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Installing ABBYY FlexiCapture 10

Before purchasing the product, analyze your document processing needs and select either the local or the distributed version.

If you plan to process moderate amounts of documents (approximately 5,000 pages per day), employ one or two operators for the
job, and do not require any sophisticated batch routing, then Local Installation is the best choice.

If you plan to automate data capture and processing, require sophisticated batch routing based on document or batch types, and
need a scalable pool of centrally administered workstations, then select Distributed Installation.

Note: When installing the program under Windows Vista, Windows 7, Windows Server 2008 or Windows Server 2008 R2 opera-
tions systems, the UAC must be disabled before installation or the native administrator account must be used.

Important! The distributed and local versions cannot be installed on the same computer.

Standalone Installation

The following installation methods are available to install the standalone version of ABBYY FlexiCapture:
. manually (interactive installation)

. from the command line

Interaction of the system components

The following figure displays the system component interaction for standalone installation:

Administrator

Station Operator Station

FlexiLayout
Studio

T
P

Licensing Server
TCP/IP 10040

FormDesigner

If you have one license and several operator stations, then for connecting operator stations to the Licensing Server, the 10040 port
has to be opened manually in Firewall settings.

Manual (interactive) installation
To install the standalone version of ABBYY FlexiCapture:

1. In the Autorun menu, select Standalone Installation (you can run the autorun.exe file manually).

2. Select a setup language. The setup program will compare the locale of your system and the selected language. If the lan-
guages are incompatible, a warning message is displayed.

3. Next, the setup program checks the version of your operating system and the availability of the administrative permis-
sions. If the version of the operating system is not supported by the program or you do not have the administrative per-
missions, a warning message is displayed and the setup program is terminated.

4.  Ifall the checks are passed successfully, the end-user license agreement will be displayed. Read the license agreement
carefully and if you agree with the terms of the agreement, select the corresponding option and click Next.

5. A dialog box will open prompting you to enter some information about yourself. Enter the required information and con-
tinue with the installation.

6. In the next dialog box, select one of the available installation modes:

. Administrator Station — The setup program installs the Administrator Station, FormDesigner 10, and FlexiLayout
Studio 10.

. Operator Station — The setup program installs only the Operator Station. (The Administrator Station, FormDe-
signer 10 and FlexiLayout Studio 10 will not be installed).



. Administrator and Operator Station — The setup program installs the Administrator Station, the Operator Station,
FormDesigner 10 and FlexiLayout 10. By default this configuration is installed.

7. Next, select a destination folder. By default, the program is installed to %systemdrive%\Program Files\ABBYY Flex-
iCapture 10. If there is not enough space on the selected hard disk, a window is displayed showing your hard disks, the
available free space, and the space required by the installation. Select a disk with sufficient free space and continue with
the installation.

8. The program files will be copied onto your computer. Once the installation is finished, the setup program will display a
message saying that the application has been successfully installed.

9.  FlexiCapture 10 License Manager will be launched automatically so that you can activate your serial number. See the
Managing Licenses section for details.

Note: For information about configuring multiple workstations to work with a single license server, see “Connecting stations to
the Protection Server”.

Command line installation

In the default configuration, all recognition languages are installed on the local computer and the interface language is selected
automatically based on the regional settings of the computer on which the program is installed. The default configuration includes
the Administrator and Operator stations, guides, help files, ABBYY FlexiLayout and ABBYY FormDesigner tools and FlexiCap-
ture 10 License Manager.

Run the setup.exe file located in the administrative installation folder using the command line options described below.

Advertise installation
For advertise installation, type
Setup.exe /j

The stations icons will appear in the Start menu. Clicking this icon automatically installs the program in default configuration.
Clicking the Administrator Station icon installs the Administrator Station, guides, help files, ABBYY FlexiLayout and ABBYY
FormDesigner tools and FlexiCapture 10 License Manager.

Clicking the Operator Station icon installs the Operator Station, help files and FlexiCapture 10 License Manager.

Silent installation

In the case of silent installation, no setup dialog boxes are displayed and the program is installed in default configuration.
Setup.exe /qn

Change “/qn” to “/qb” if you want an installation progress bar to be displayed.

No other dialog boxes will be displayed.

Additional command line options

/L<language code> disables auto selection of the interface language and installs the program with the interface language you spe-
cified.

The following language code values are available:
1033 English

1049 Russian

1031 German

1036 French

2052 Chinese simplified
1040 Italian

1034 Spanish

2074 Serbian

1029 Czech

1038 Hungarian

1045 Polish

1046 Portuguese (Brazilian)
1042 Korean

/V <command line> passes the specified command line directly to msiexec.exe. The <command line> string can be replaced with
the following commands:

INSTALLDIR="<destination>" — the path to the folder where ABBY'Y FlexiCapture 10 is to be installed.
SETUPTYPE_CMD="<install mode>" — available installation modes.
The following modes are available:

Full — Full installation (the Administrator and the Operator Stations, guides, help files, ABBYY FlexiLayout and ABBYY Form-
Designer as well as License Manager will be installed)



Admin — Administrator Station (the Administrator Station, guides, help files, ABBYY FlexiLayout and ABBYY FormDesigner
as well as License Manager will be installed)

Operator — Operator Station
Example:
Setup.exe /qn /L1049 /v INSTALLDIR="D:\FC10" SETUPTYPE CMD=Full

As a result, the Administrator and Operator Stations will be installed into D:\FC10, and Russian will be used the language of the
interface.

Removing ABBYY FlexiCapture in silent mode
msiexec /x { FC100000-0004-0000-0000-074957833700}

Distributed Installation

For distributed installation, it is recommended that a server operating system should be used. Windows XP, Windows Vista and
Windows 7 are not server operating systems. They support only a limited number of connections and are not well suitable for
Server use.

The following three steps are required to install the distributed version of ABBYY FlexiCapture:
1. Prepare the Application Server.
2. Install the servers.

3.  Install the workstations.

Preparing the Application Server for installation on Windows 2008 R2
This instruction can also be used when installing the Application Server on Windows 2008, Windows 7 and Windows Vista.
Important! Before you start, disable the UAC or perform all actions using the native administrator account.
To disable UAC:
1. In Control Panel open User Accounts.

&%, User Accounts P ]
G\: :’;v FPJ + Control Panel = User Accounts ~ User Accounts - l‘nl I Search Control Panel g
(7]

Control Panel Home Make changes to your user account

Manage your credentials Change yaour password e —

Create a password reset disk Remave your password J Administrator

) ‘ . Administrator
Manage your file encryption Change your picture u Password protected
certificates |

Configure advanced user profile

properties ¥ Manage another account

Change my environment variables 'ﬂi' Change User Account Control settings

2. Click Change User Account Control settings link and in the dialog box that opens, decrease the level of user control
to Never notify.



@1 User Account Control Settings

=10l x|
-
Choose when to be notified about changes to your computer
User Account Contral helps prevent potentially harmful programs from making changes to your computer.
Tell me more about User Account Control settings
Always notify
- - Never notify me when:
® Programs try to install software or make changes to my
computer
- - & [ make changes to Windows settings
Mot recommended. Choose this only if you need to use
programs that are not certified for Windows 7 because
-1 they do not suppart User Account Contral.
Mever notify
[
5 oK | Cancel |
3. For changes to take effect, restart the computer after turning off UAC.

The distributed installation of FlexiCapture 10 includes three servers:
. Application Server
«  Protection Server

«  Processing Server

The Application Server coordinates the work of the stations ensures the correct operation of ABBYY FlexiCapture 10. The fol-
lowing components must be installed on your computer before you can install the Application Server:

. Net Framework 3.5

By default this component is included in Windows 2008 R2 (except the version Core). It must be installed via Server Manager ->
Features — Add Features.
To install .Net Framework 3.5, do the following:

1.

In My Computer local menu, choose Manage.
2.

In the Server Manager console that opens, choose Features. In the right window click Add Features and from the fea-
tures list select .Net Framework 3.5.1 Features.

Ez Server Manager

=101x]
Ele Acton View Help
Lt A S ESll 7|

R ServerNanager (VIN-COSL.0A%
i’ Roles

il Features

m Diagnostics a View the status of features installed on this server and add or remove features,
jj‘j Configuration % i

Eﬂ Storage

'_‘ lﬁml’l’lﬂ\ eatures summary Relp
Eeatures Summary [d Features 5 Hel

+| Features: 1of 41installed gﬂ Add Features
é Remove Features
Remote Server Administration Tools
Role Administration Tools
Web Server (II5) Tools

=

{; Last Refresh: Today at 7:38 AM  Configure refresh

© 2011 ABBYY. All rights reserved.



Add Features Wizard x|

Select one or more features to install on this server.
Confirmation Eeatures: Description:

Progress Microsoft .NET Framework 3.5.1
Results ["] Background Inteligent Transfer Service (BITS) ;?:‘r:el:visrl:':up;;:r\:;;h:aﬁt—r
[[] BitLocker Drive Encryption technologies for building applications
[] BranchCache that offer appealing user interfaces,
[] Connection Manager Administration Kit protect your customers’ personal
[] Desktop Experience identity information, enable seamless

and secure communication, and
[] DirectAccess Management Console provide the ability to model arange of

[ Group Policy Management business processes.
[] tnk and Handwriting Services

[] Internet Printing Client

|:| Internet Storage Mame Server

[] LPR Port Monitor
[] Message Queuing

[] Multipath 1/0

[] Metwork Load Balanding

[] Peer Name Resolution Protocol

[[] Quality Windows Audio Video Experience

[ rRemote Assistance

[ Remote Differential Compression
ﬂ IS Remote Server Administration Tools (Installed) | _’lﬂ

More about features

< Previous | Mext > | Install | Cancel

3. The dialog box that opens will prompt you to add features required for installation of .Net Framework 3.5.1. In this
window, click Add Required Features

Add Features Wizard |

on Add features required for NET Framework 3.5.1 Features?

W
-y
You cannat install . MET Framework 3.5.1 Features unless the required features are also installed.
Features: Description:
=] Windows Process Activation Service Windows Process Activation Service
generalizes the IS process model, removing
Frocess Model the dependency on HTTF. All the features of
-NET Environmertt 115 that were previously available only to
Conrfiguration APls HTTP applications are now available to

applications hosting \Windows
Communication Foundation (WCF) services,
using non-HTTF protecols. 15 7.0 also uses
Windows Process Activation Service for me..

[ 2dd Required Featres | Cancel |

@ Why are these features required?

4. In the next step, click Install.

© 2011 ABBYY. All rights reserved.



Add Features Wizard

X
Bt Confirm Installation Selections
E
Features
. To install the following roles, role services, or features, dick Install.
Confirmation
® 1informational message below
Progress
Results

@ This server might need to be restarted after the installation completes
~) MET Framework 3.5.1 Features
NET Framework 3.5.1
WCF Activation
HTTP Activation
Non-HTTP Activation

~) Windows Process Activation Service
Process Model
JNET Environment
Configuration APIs

Print, e-mail, or save this information

< Previous | Mext > | Install I Cancel |

5. During installation, Windows may ask for the source distribution files, so you need to have Windows installation CD.

On other operating systems, (Windows 2008, Windows 2003) this component can be installed by selecting Install External Com-
ponents in the Autorun menu.

Note: You can find information about the installed versions of Net.Framework in the registry. For more information, please refer
to the Microsoft web-site.
. IIS (Internet Information Services)

The Application Server can only be installed on a computer on which Microsoft Internet Information Server 5.1 or later is in-
stalled. IIS is required for the correct operation of the Application Server, the Administration and Monitoring Console and Web
Data Verification Station.

To install IIS, do the following:

1. In My Computer local menu, choose Manage.
2. In the Server Manager console, that opens click Add Roles and from the roles list select Web Server (IIS).
=10l x|
File Action View Help
o Al

i‘ Roles
Eﬁ Features
i Diagnostics View the health of the roles installed on your server and add or remove roles and features.
iﬁ’j Configuration f’
g Storage

#! Roles Summary Roles Summary Help

~! Roles: 0 of 17 installed _—;_*ﬁ Add Roles

= Remove Roles

4 | | ﬂ %:; Last Refresh: Today at 4:32 AM  Configure refresh

© 2011 ABBYY. All rights reserved. 10


http://support.microsoft.com/kb/318785

Add Roles Wizard

EE:% Select Server Roles

Before You Begin

Select one or more roles to install on this server,
Roles:

Web Server (115)

|:| Active Directory Certificate Services
Role Services [] Active Directory Domain Services
|:| Active Directory Federation Services

Confimation [] Active Directory Lightweight Directory Services
Frinre [] Active Directory Rights Management Services
Results |:| Application Server

D DHCP Server

[] DMs server

|:| Fax Server

[ File Services

] Hyper-v

] Metwork Policy and Access Services
D Print and Document Services

[ remote Desktop Services

Web Server (IIS)
[ windows Deployment Services
[ windows Server Update Services

More about server roles

Description:

Web Server (I1S) provides a reliable,
manageable, and scalable Web
application infrastructure.

< Previous | Mext > I Install | Cancel |

During installation, Windows may ask for the source distribution files, so you need to have Windows installation CD.

Enable installation of the following IIS internal components:
-> Web Management Tools

-> [IS Management Console
->[IS 6 Management Compatibility

->[IS 6 Metabase and IIS 6 configuration compatibility
->IIS 6 Scripting Tools
-> World Wide Web Services
-> Application Development Features
> ASP.NET
-> ISAPI Extensions
-> Common HTTP Features
-> Static Content
-> Security
-> Windows Authentication
-> Basic Authentication

Components associated with these internal components will also be enabled. Here is the list of components installed for

IS 7.5:

© 2011 ABBYY. All rights reserved.
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Web Server
Comrmon HTTP Features
Static Content

Default Document

Application Development
ASP.NET

.MET Extensibility
ISAFPI Extensions
ISAPI Filters

Security
Basic Authentication

Windows Authentication
Request Filtering

Management Tools
115 Management Console

115 & Management Compatibility
IIS & Metabase Compatibility

IIS 6 WMI Compatibility
IIS & Scripting Tools

Other IIS components can be installed according to user preferences, e.g., perform a complete installation of IIS.

Preparing the Application Server for installation on Windows 2003
This instruction can also be used when installing the Application Server on Windows XP.
The following components must be installed on your computer before you can install the Application Server:
. Net Framework 3.5 SP1
This component, together with a number of other components, can be installed by selecting Install External Components in the
Autorun menu.
. IIS (Internet Information Services)
To install IIS, select Add or Remove Programs—> Add/Remove Windows Components.

ol X

Currently installed programs: [T show updates Sark by Imame j
) Microsaft \MET Framewark 1.1 Size  36,15ME =
@ Microsoft MET Framewark 2.0 Service Pack 2 Size  184,00ME

ﬁl Microsoft \MET Framework 3.0 Service Pack 2 Size  159,00MB

ﬁ_%l Microsoft .MET Framework 3.5 5P1 Size  28,253ME

ﬁl Microsoft Device Ennulator version 1.0 - ENU Size 1,38ME J
ﬁl Microsoft Docurnent Explorer 2005 Size  26,61ME

@ Microsaft Firewall Clienk Size 0,75MEB

E] Microsoft Office 2003 Russian User Interface Pack Size  137,00ME

© 2011 ABBYY. All rights reserved.
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Windows Components Wizard

Windows Components
Y'ou can add or remove compaonents of Windows.

To add or remove a component, click the checkbox. & shaded box means that only
part af the companent will be installed. To see what's included in a component, click
Details.

LConponemts:

ﬁ.u:u:essu:uries and Utilities 275 MB
& Application Server 15.4 ME
[ [BA Certificate Services 1.4 ME

O E-mail Services 1.0 MB
[ &4 Fax Services AR MR ;I

Dezcrption:  Includes Intemet Information Services (115] and the Application Server

Conzole,
Total disk. space reguired: E.9 B
Space avallable on digk: 57007 MB

< Back | Hest > | Cancel | Helm

Application Server x|

To add or remove a compaonent, click the check box. & tshaded box means that only part
of the component will be installed. To see what's included in a component, click Details.

Subcomponents of Application Server:

| % Application Server Conzole 0.0rBE ;I
@ Enable nebwark, COM+ access 0.0rBE
O @ Enable netvwark DTC access 0.0B

2 Y& Internet Information Services [115) 5.9 MB

[ = teszage Queuing £.5 ME

[

Description: 115 includes HTTP, FTP, SMTPF, and MMTP zuppart, alang with zuppart
fior Active Server Pages [S5P).

Total dizk zpace required: 287 MB Details |
Space available on dizk: h328.E MB
| ak. I Cancel |

13



Internet Information Services (II1S) x|

To add or remove a companent, click the check box. & tshaded box means that only part
of the companent will be installed. To zee what's included in a component, click Details.

Subcomponents of Internet Information Services [I15];

» Comman Files 10ME =]
| &D File Transfer Pratocal [FTP] Service 0.1 HB
tﬁj Internet Information Services Manager 1.2 B
[ @Intemet Prirting 0.0 ME
(] EEENNTP Service 1.9 MB
[ sz SMTP Service 1.9MB
o World \Wide Web Service 2.3 MB ;I

Description:  Includes support for thrattling and restarting data transfers, and a BITS
management conzole extension.

Toatal dizk zpace required: 287 MB Details |
Space available on dizk: h328.E MB
| k. I Cancel |

World Wide Web Service x|

To add or remove a compaonent, click the check box. & shaded box means that only part
of the component will be installed. To zee what's included in a component, click Details.

Subcomponents of Wiarld Y/ide Web Service:

[ |#] Active Server Pages 00ME =]
O Intermet Oata Cannector 0.0 MB
[] <> Remate Desktop ‘weh Connection 0.4 MB
O |%] Server Side Includes 0.0 B
[ |%]webDaY Publishing 0.0 ME

forld “wide wWeb Service

[

Description: A core component af [15 that uges HT TP to exchange information with
“Web clients on a TCPAAP network.

Total dizk zpace required: 287 MB [ etails |
hE28.6 B

Space available on dizk:

k. I Cancel |

During installation, Windows may require files from the setup disk, therefore be sure to have the Windows disk ready at hand.

If any of the components is missing on your computer, the setup program will display a warning message and the installation of
the Application Server will stop.

Once the installation is complete, open the Administrator Console and make sure that the IIS service is running.

Important! In Windows 2003 ASP.NET is disabled by default for security reasons. This will cause “Error 404 File not found”

when you attempt to start the Monitoring Station. To solve the problem, allow the ASP.NET v2.0 service extension in the IIS
Manager:

14



% Services

WHI Control

B8 Indexing Service

E--f"g Internet Information Services (115) Manager
_,_J Application Pools

Fl- ) Weh Sites

(—_,_J Web Service Extensions ]

L add & new web service extension...

E allow all Web service extensions For a
specific application...

L prohibit ll web service extensions

@ Dpen Help

E Computer Managemenkt - |EI|5|
g File Action Wiew window  Help | =l |
e |EEERB (@2 =
Q Computer Management (Local) @ web Service Extensions
El‘m Systern Tools
D"@ Event Yiewer /| web Service Extension | Status |
D'"% Shared Foldars “F all Unknown CGI Extensions Prohibited
B e Local Users and Groups Al o ] “F &l Unknown 1S4P1 Extensions Prahibited
-] Performance Logs and Alerts ] Active Server Page Prohibited
Y, Device Manager Frakitt P TET "
-5 Storage - e .
= % =) Rgmovable Storage Properties %[ Internet Data Connector Prohibited
=
EQ' bi Server Side Includes Prohibited
-l Disk Defragmenter o
Disk Managament Taske WebCuiy Prohibited
EI--& Services and Applications
-5 Telephary

Extended A Standard 7

This service extension will appear in the list only after you install NET Framework 3.5 SP1.

If ASP.net was installed before installation of IS, registration of ASP.net must be performed:
%systemdrive%\Windows\Microsoft. NET\Framework\v2.0.50727\aspnet_regiis.exe —i

If your computer runs Windows 2003 (64-bit) or Windows XP (64 bit), do the following:

1.  Execute the following command from the command line: cscript % system-
drive% \Inetpub\AdminScripts\adsutil.vbs set W3SVC/AppPools/Enable32BitAppOnWin64 true

This command switches the default pool to 32-bit mode, thus the default pool and the pools of the Administration and

Monitoring Console run in the same mode which is required for registration of ASP.net.

For this command to take effect, access to the Network Service account must be granted explicitly. To grand access to

the Network Service account, execute the following command: aspnet_regiis -ga "NT Authority\ Network Service".

2. Make sure that the World Wide Web Publishing service is running in 32-bit mode:

15



World Wide Web Publishing Properties (Loca

General I Lag Dnl Recaven Dependenciesl

Service name:
Dizplay name:

Deszcription;

Path to executal

Wl 35YE

2l x|

Frovides Web connectivity and administration
through the Intermet Information Services snap-in

rs

[]

C:\wMD DWﬁ '\s_l,lstemSEHhetsw’\inetinfD.e:-te

Startup type: I.&utumatic j
Service statuz:  Started
Shart Stop | Pauze Hesume |

Yiou can specify the start parameters that apply when pou start the zervice

fram here.

Start parameters:

QK I Cancel

Aol

3. Execute the following command from the command line:
% systemdrive% \Windows\ Microsoft.NET\Framework\v2.0.50727\aspnet_regiis.exe —i

4.  The list of IIS service extensions (see below) will now include an entry for the 32-bit version of ASP.Net. Change its

status to allowed:

'E. Internet Information Services (I15) Manager

"a Eile  Action  Yiew Window  Help

e | AR EFHNE 22> =0

|'_+'j ) Application Paols

?:j Internet Information Services . Web Service Extensions
-0 GROMIT-2K3-64 (local com

Add a new Web service extension. .

Installing the servers

Allow &l Web service extensions For a

Once you have made the preparations for installing the Application Server, install the servers.

: A I ‘Web Service Extension I Skakus |
Lﬂ ) Weh Sites 7 all Unknown C&I Extensions Prohibited
L) Ausaeeitie e Al _g All Unknawn ISAPT Extensions Prafibited
" Active Server Pages Allowveed

Sl P.HET v2,0,50727 Prohibited
Properties ), WET 507 Aliowed
FlexiCapture Web Services Allowsed
B Inkermet Data Connector Allowed
Tk @ Server Side Includes Alloed
[ webDay Allowed

By default, all servers are installed on the same computer. However, you can install them on different computers by disabling the

redundant servers in the setup program.
To install the ABBYY FlexiCapture servers:

1. In the Autorun menu, select Distributed Installation. Next, select Install Servers to start the installation.

2. Select a setup language. The setup program will compare the locale of your system and the selected language. If the lan-
guages are incompatible, a warning message is displayed.

3. Next, the setup program checks the version of your operating system and the availability of the administrative permis-
sions. If the version of the operating system is not supported by the program or you do not have the administrative per-

missions, a warning message is displayed and the setup program is terminated.
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10.

If all the checks are passed successfully, the end-user license agreement will be displayed. Read the license agreement
carefully and if you agree with the terms of the agreement, select the corresponding option and click Next.

A dialog box will open prompting you to enter some information about yourself. Enter the required information and con-
tinue with the installation.

Next, select the servers to install. You can also specify a destination folder. By default, the program is installed to:
%systemdrive% \Program Files (x86)\ABBYY FlexiCapture 10 Servers ((%systemdrive%\Program Files\ABBYY
FlexiCapture 10 Servers if 32-bit OS version is used).

. Processing Server — the server that controls the operation of the Processing Stations

.  Protection Server — the server that stores and manages licenses. When you install servers on different worksta-
tions, you must specify the address of this server or the Protection Server in the format server, without \\ or http://

. Application Server — the server that controls the operation of the other components. When you install servers on
different workstations, you must specify the address of this server or the Application Server in the format server,
without \\ or http://

«  Web Stations — the Application Server components which allow operators to connect to the server and work using
a web-browser.

. Web Stations Authentication Module — the Application Server component which allows operators of web stations
to register with the system and create requests for access rights to the web station. Provides operators of web sta-
tions with a single entry point into the system. Installing this component is available on IIS 7 or later

. Stations Installer — selecting this option will copy the stations’ setup files onto the Application Server so that you
can then deploy them from the server. SMS and Active Directory deployment are supported. Once you select this
component, you can specify the destination folder where to copy the setup files.

Next the setup program will check if Net Framework 3.5 SP1 and IIS are installed on your computer. If any of the com-
ponents is missing on your computer, the setup program will display a warning message.

The program files will be copied onto your computer. Once the installation is finished, the setup program will display a
message saying that the application has been successfully installed.

Once the installation is complete, FlexiCapture 10 License Manager will be launched automatically so that you can ac-
tivate your serial number. See Managing Your Licenses section for details. The Monitoring Station will also be
launched, where you can set up the installed Application Server.

After the installation is complete, in the IIS Manager console (Start -> Administrative Tools -> Internet Information Ser-
vices (IIS) Manager), check if IIS server and Default Web Site are running:

'?Elnternet Information Services (IIS) Manager O 5[
@ « o | % » wmcosicuomraa | @ = @ -
File Wiew Help
i @) WIN-COSLCUOARGA Home
.- | | |#, ‘ Manage Server
e Restart
aRcA (wiN-(IR 7 f8ce - Eshowal |Groupby: - b start
Application Pools ASP.NET = B st
E-14] sites ) J—
-8 Default Web Site :E% @, (% 9# View Application Pools
= A LER
NET NET \NET Error NET NET Trust ew
Authorizati... Compilation Pages Globalization Levels ._é. Help

of g‘? E !‘\?;‘ Online Help

Application Connection  Machine Key ~ Pages and Providers

Settings Strings Contrals
&L &
=

Session State  SMTP E-mail

&
B

& 8 [
e ] .ﬁ.
Authentication CGL Compression Default

Document

B & =
=3 <‘Fi1 <«
Directory Error Pages FastCGl Handler HTTP LI
4| | » | = Features View |/ = Content View
Ready ei:i

If the server is stopped, in the Manage Server menu, choose Start. Similarly, check whether Default Web Site is running.

IMPORTANT! The Application Server should be available on the Internet if you wish to use the remote stations over the Inter-

net.
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External components required for the correct operation of the system
o Ikey driver

This component is required if you are going to use a USB key license. On Windows 2008 R2 or another 64-bit operating
system, it is necessary to install a 64-bit version of iKey driver manually. It can be installed by selecting Install External
Components in the Autorun menu.

Note: On 32-bit operating systems, no additional steps are required to install the iKey driver. Installation will be done
automatically.

o Microsoft Core XML Services (MSXML6)
This component is required for the operation of the Application Server. It is installed automatically.

«  Crystal Reports

This component is used by the Administration and Monitoring Console to generate reports. Crystal Reports can be in-
stalled on the same computer where the Application Server is installed. Without this component, you will not be able to
generate reports. However, all other Application Server management functionality will be available. ABBYY FlexiCap-
ture 10 supports Crystal Reports 2008 and 2010. Crystal Reports is not installed automatically and should be installed
manually. A 32-bit version of Crystal Reports 2008 can be installed by selecting Install External Components in the Au-
torun menu.

Note: Whether to install a 32- or 64-bit version of Crystal Reports is determined by the mode, in which the pool of the
Administration and Monitoring Console is running in IIS (FlexiCapture 10 Monitoring). For details, see «System com-
ponents in IIS and their configuration». By default the pool of Administration and Monitoring Console runs in 32-bit
mode. However, it can be transferred to 64-bit mode, which allows you to use Crystal Reports 64-bit. For details, see
«Switching system components to 64-bit mode>.

If the bit does not match the following error message will appear:

A runtime error occurred:

CrystalReports loading failed

Details:

Description Exception has been thrown by the target of an invocation.

Source mscorlib

Stack trace at System.RuntimeTypeHandle.Createlnstance(RuntimeType type, Boolean publicOnly, Boolean noCheck,
Boolean& canBeCached, RuntimeMethodHandle& ctor, Boolean& bNeedSecurityCheck) at Sys-
tem.RuntimeType.CreateInstanceSlow(Boolean publicOnly, Boolean fillCache) at Sys-
tem.RuntimeType.CreateInstancelmpl(Boolean publicOnly, Boolean skip VisibilityChecks, Boolean fillCache) at Sys-
tem. Activator.CreateInstance(Type type, Boolean nonPublic) at System.RuntimeType.CreateInstancelmpl(BindingFlags
bindingAttr, Binder binder, Object[] args, Culturelnfo culture, Object[] activationAttributes) at Sys-

tem. Activator.Createlnstance(Type type, BindingFlags bindingAttr, Binder binder, Object[] args, Culturelnfo culture,
Object[] activationAttributes) at System.Reflection. Assembly.CreateInstance(String typeName, Boolean ignoreCase,
BindingFlags bindingAttr, Binder binder, Object[] args, CultureInfo culture, Object[] activationAttributes) at ReportMa-
nager.loadCrystalReports()

System components in IIS and their configuration

Application pools
During the installation of the Application Server, the installer automatically adds two IIS application pools associated with

ABBYY FlexiCapture 10. Application pools enable interaction with workflows bound to one or more applications and sharing

data between them.
FlexiCapture 10 Monitoring — enables operation of the Administration and Monitoring Console
FlexiCapture 10 Web Services — enables operation of the Application Server.

Both pools are configured automatically during the installation of ABBYY FlexiCapture. Pool settings critical for correct opera-

tion of the Application Server, are listed below:
- .Net Framework Version = v2.0
- Managed Pipeline Mode = Integrated

- Identity = NetworkService
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Besides, Web Data Verification Station, Web Scanning Station and Web Capture Station will be added to DefaultAppPool (de-
fault IIS pool).

ABBYY FlexiCapture 10 application pools work in 32-bit mode. In IIS Manager Console, you can check if 32-bit mode is
enabled. For this, do the following:

1. Run the IIS Manager Console from the menu: Start -> Administrative Tools -> Internet Information Services (IIS)

Manager.
E Internet Information Services (IIS) Manager =1olx]
@ @ [ €2 » WIN-COSLCUCARGA » ] @ -
File View Help
@ WIN-COSLCUOARGA Home
6;- H | |& 4 Manage Server
'Qﬂ Start Page ¥+ Restart
Filter: - Go - Show All | Group by: _ l
EI---aj % %I | 2 b start
Application Pools ASP.NET = ™
& Sites ‘g B Stop
4% Default Web Site i= N2 [ ‘-‘i View Application Pools
A © ® g pi
NET NET NET Error {NET JMNET Trust View S
Authorizati...  Compilation Pages Globalization Levels @ Help
L] ﬁ >, Online Help
ab| 7! e}
Connection ~ Machine Key  Pages and Providers
Strings Controls
Session State  SMTP E-mail o
s
o I
2 €GI ] @
ASP Authentication CaI Compression Default
Document
"
&
Directory Error Pages FastCGI Handler HTTP LI
J || e e
Ready eﬂ.:i
2. Choose Application Pools.
™E Internet Information Services (IIS) Manager =1alx]
@ @ | 2 » wincosLcUOARGA + Application Pools & < @ -
File View Help
i@! Application Pools o I
4 Lz Add Application Poal...
X . . L Set Application Pool Defaults. ..
j WIN-COSLCUOARGA (WIN-COSLCUOARG This page Iei_s you view and manage the Ils_t of application pools on ihe_
server, Application pools are assodated with worker processes, contain one Application Pool Tasks
or more applications, and provide isolation among different applications. b
Start
Filter: - %go - %Show Al |Group by: s B stop
% aspnet_diem.: MName = I Status | .NET Framewaor... | Managed 3 Recyde...
Dla“—‘_""e”ﬁa“"” 2} Classic .NET AppPool Started  v2.0 Classic e -
FlexiCapture10 @Dei’aultAppPool Started  v2.0 Integrate it Applica
[E¥FlexiCapture 10Monitoring  Started 2.0 Integrate | |[5] Basic Settings...
&FIE)dCapmre 10 Web Services Started  NoManaged Code  Classic Recyding...
Advanced Settings. ..
Rename
K Remove
View Applications
@ nep
Online Help
| | i
Ready qﬂ.:i
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3. Choose a desired pool from the list. In the Actions menu, select Advanced Settings...

H (General) =
NET Framework Version v2.0
Enable 32-Bit Applications I True I
Managed Pipeline Mode Integrated
MName FlexiCapture 10 Monitoring
Queue Length 4000
Start Automatically True
= CrPu
Lirnit 1]
Limit Action NoAction
Limit Interval (minutes) [1]
Processor Affinity Enabled False —
Processor Affinity Mask 4294967295
= Process Model
Identity NetworkService
Idle Time-out (minutes) 20
Load User Profile False
Maximum Waorker Processes 1
Ping Enabled True
Ping Maximum F.esponse Time (seconc 90
Ping Period (seconds) 30
Shutdown Time Limit (seconds) a0
Startun Time |imit (eernndst an hl
Name
[name] The application pool name is the unique identifier for the application poal,
oK | Cancel |
A

The value of Enable 32-Bit Application must be True. It means that the pool works in 32-bit mode.

Besides, the installer adds the following applications to Default Web Site (the set of applications depends on the configuration
selected during the installation):

Default Web Site\FlexiCapturel0 — the Administration and Monitoring Console

Default Web Site\FlexiCapturel0\Server - the Application Server, including Default Web
Site\FlexiCapturel0\Server\WebServices.dll (a web service of the Application Server which supports both Windows and Basic

authentication).

Default Web Site\DataVerification — Web Data Verification Station (will be added if the Web Stations component is selected
during the installation of ABBY'Y FlexiCapture 10 Servers)

Default Web Site\Scanning — Web Scanning Station (will be added if the Web Stations component is selected during the installa-
tion of ABBYY FlexiCapture 10 Servers)

Default Web Site\Capture — Web Capture Station (will be added if the Web Stations component is selected during the installa-
tion of ABBYY FlexiCapture 10 Servers)

Authentication settings for FlexiCapture 10 Web Applications
To control access to the applications via http protocol, it is necessary to configure authentication settings (login/password-based

connection verification of a user’s identity). For this, choose a desired application and then choose the Authentication item.
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?E Internet Information Services (IIS) Manager - |EI|1|
@ @ [ [ » WIN-COSLCUOARGA * Sites b DefaultWebSite » FlexiCapture1d » ] @ < @ -
File  View Help
_- q FlexiCapture1l0 Home LN
e’a' ltl |ﬁ |& LES f p Open Feature
' StartPage
€3 WIN-COSLCUOARGA (WIN-COSLCUOARG| | TItEr: - (o - iy show All | Group by: o || & Ezpk”e
T Edit Permissions...
Q Application Pools ) - R
‘é & [E] Basic settings...
(BVED ik E =
Providers ~ Session State  SMTP E-mail View Virtual Directories
Manage Application L)
| App_Browsers s Browse Application
- Browse *:80 (http)
@ Advanced Settings...
Compression @ Help
Online Help
P server u:}j
(V] &=
Default Directory Error Pages Handler
Document Browsing Mappings
= il
Logging MIME Types Modules
. o
Ready iiE'.:E
Then select a required authentication method from the list and enable it.
1’E Internet Information Services (IIS) Manager - | Dlﬂ
@ @ [ P » WIN-COSLCUDARGA + Sites b DefaultWebSite b FlexiCaptureld ¥ J G o g @ -

File \View Help

€|

----- &5 Start Page
=3 WIN-COSLCUOARGA (WIN-COSLCUOARG
H J Application Pools
B-[8] Sites
E-€) Default Web Site
|| aspret_dient
P DataVerification
FlexiCapture 10
| App_Browsers
[ App_Themes
] bin
"] CustomReports
] Help
[ ] Images
| Reports
? Server

1| | 3

&) Authentication

=

Forms Authentication
Wind \uthentication

4

Group by: Mo Grouping <

Name = | status | Response Type

Anonymous Authentication Disabled

ASP.MET Impersonation Disabled

Basic Authentication Disabled HTTP 401 Challe
Disabled HTTP 302 Login

Enabled

HTTP 401 Chall

[ =] Features View |/ Content View

Configuration: ‘localhost’ applicationHost. config , <location path="Default Web Site/FlexiCapture10™>

Click here to learn how to

configure Extended Protection.

Disable

Advanced Settings...
Providers. ..

@ Help

Online Help

hE

To access ABBYY FlexiCapture 10 applications, the 3 types of authentication are used:

Windows authentication — a user tries to login to the server using the same credential under which the user browser runs.

Basic authentication — login and password are transmitted over the network in clear text.

Anonymous authentication — the server does not require the client to transfer the credential.

Authentication settings are configured by the installer automatically, however if you later change the settings manually, some

parts of the system will become unavailable. In this case, modify them the following way:

Default Web Site\FlexiCapturel0 (Administration and Monitoring Console) - only Windows authentication:

© 2011 ABBYY. All rights reserved.
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E Server Manager

=10l x|
Ele Action View Help
Rl 2 ] sl 7
i ?EWEF LEWE S (e Rellslil 1nternet Information Services (IIS) Manager
El 5 Roles
B @ Web server (I15) €15 | « Sies » DefaltWebSite b FlexiCapureid [k < 1@ -
W) Internet Information Se =
5 restres Comections P - Acions
aanosti Authentication
1 Diagnostics u’v H |ﬁ |& I, @ Help
} Configuration Start Page Online He}
. ) . nline Help
Storage WIN-COSLCUGARGA (WIN-C Group by: No Grouping
J Application Pools Name = Status
@] Sites Anonymous Authentication Disabled
B9 Default Web Site ASP.MNET Impersonation Disabled
|| aspnet_dient Basic Authentication Disabled
DataVerification Forms Authentication Disabled
FlexiCapture10 Windows Authentication  Enabled
|| App_Browsers
| App_Themes
| bin
] CustomRepor
| Help
|| Images
| Reports
P Server
q | DK | »
= =S 5:04AM
rgsmh% a - 2 [ L
"

1147/2011

Default Web Site\FlexiCapturelO\Server (Application Server) - both Windows authentication and Basic authentication are
enabled:

i Server Manager ;Iglil
File  Action View Help
Rl A i 7|
f},l; ?EI’VEF REWELEENNSEe RISV 1nternet Information Services (IIS) Manager
El 5* Roles
£l € Web Server (15) @ (5 | « Stes » DefautwebSte » FlexCaptrel b Server b & 5@ -
W) Internet Information Se :
5 Festures Comnections @ . Adions
—onost Authentication
1 Dlagnoshcs. @- [ |7 |8 I, @ rep
| Configuration Start Page online Hel
. ) . nline Help
Storage WIN-COSLCLIOARGA (WIN-C Group by: Mo Grouping
£} Application Pools Neme - Status
Q Sites {Anonymous Authentication Disabled
=140 Default Web Site Basic Authentication Enabled
|| aspnet_client Windows Authenticaton  Enabled
¥ Dataverification
FlexiCapture 10
App_Browsers
|| App_Themes
bin
CustomR.epor
|| Help
Images
|| Reports
Server
a1 ]
q DK | »| [=]Features view |/ = Content View

Default Web Site\DataVerification (Web Data Verification Station) - only Anonymous authentication is enabled:
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E,, Server Manager ;Iﬂlll

Fle Acton Wiew Help
9| s1=H
ia Server Manager [(liyRee=ReVelil [nternet Information Services (IIS) Manager
El 5 Roles —
= @ web Server (I15) @ " [ 4 Sites » DefaultWeb Site » DataVerification » ] 4] far 1@ -
3 Fetres Comnections . Actens
o ‘i Authentication

\ﬁ-_ Internet Information Se

#m Diagnostics Q-7 |8 = @ Hel

= R = REER]. - = p
jﬁ’j Configuration = = y

k: Start Page Online Hel
=5 storage WIN-COSLCUOARGA (WIN-C Group by: Mo Grouping < g
|2} Application Pools M
[&] Sites iAnonymous Authentication Enabled
-4 Default Web Site ASP.NET Impersonation Disabled
~| aspnet_dient Basic Authentication Disabled
¥ DataVerification Forms Authentication Digabled

FlexiCapture10
| App_Browsers
App_Themes
bin
CustomRepor
Help

Images

_| Reports
(P Server

Windows Authentication Disabled

N o

. e
| |

Default Web Site\Scanning (Web Scanning Station) - only Anonymous authentication is enabled.

Default Web Site\Capture (Web Capture Station) - only Anonymous authentication is enabled.

Web Clients Authentication Module
A new functionality, Web Clients Authentication Module, has been added in the 3" release of ABBYY FlexiCapture 10.

By default, installation of this module is disabled. It can be enabled at the step of selecting installation components. If you make
an upgrade from the previous releases of FlexiCapture 10, this component is not installed either, however it can be installed after
upgrade by using the menu Start->Control Panel>Programs and Features>Modify.

Web Clients Authentication Module can be installed on the computer with the Application Server. For its installation, IIS 7 or
later is required, besides Web Stations component of the server installation must be installed (or selected for installation).

Web Clients Authentication Module adds to IIS a new authentication type - ABBYY FlexiCapture Authentication which is to be
used by operators who work at the Web Capture, Web Scanning and Web Data Verification Stations. Besides, a web application
Login is installed, which allows operators of web stations to log into the system, register within the system and request the neces-
sary access rights from the administrator.

In this module is installed, the following changes occur in IIS:

1. A new Default Web Site\Login application is added to Default Web Site. In the settings of this application, only Ano-
nymous authentication is enabled.

2. This application is bound to the FlexiCaputre 10 Monitoring pool of the Administration and Monitoring Console.

3. A copy of the Default Web Site\FlexiCapturel0\Server\WebServicesExternal.dll web service which supports only
ABBYY FlexiCapture Authentication is added to the Application Server.

4. Web Capture Station, Web Scanning Station and Web Data Verification Station are switched to the operating mode
which uses ABBYY FlexiCapture Authentication. For this, in web.config application files, the value of the «UseCus-
tomAuthentication» key is changed to True by the installer. (Without installing the Web Clients Authentication Mod-
ule, the key value is False. In this case, the stations work without using ABBYY FlexiCapture Authentication).

For these applications, only Anonymous authentication remains enabled in authentication settings of IIS.
Handler Mappings
In IIS services, handlers process requests to sites and applications. The handlers are mapped to resources on a web server and

create responses to those requests. Like the modules, the handlers are implemented using native or managed components, such a

dynamic DLL or managed code.

During the installation of ABBYY FlexiCapture 10 Application Server, mappings required for correct processing requests from
the Application Server are added to IIS by the installer. These mappings can be view in the IIS Manager console. For this, select

the Handler Mappings item for Default Web Site\FlexiCapturel0\Server (the Application Server).
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™E Internet Information Services (II5) Manager - (o) x|

@ (3] | @ » wrvcosicuorraa » Sites  [DefaultWebSite [¥] FiexiCapture1d * Server » | = e -
Ele View Help Default Web Site
& Handler Mappings et
CMEIENTY Pping The sppcatonis i 2
qﬁ Start Page application pool that is running
= Use this feature to th ich a5 DLLs and d code, that handl for fi it X in Classic mode, so you can
95 WIN-COSLCUDARGA (WIN-COS se this feature to specify the resources, such as DLLs and managed code, that handle responses for spedific request types. et e L
2} Application Pools Groupby: State - native modules that are
E-[&] Sites mapped to paths. You must
E-€9 Default Web Site LI | path | state [ Path Type [ Hendler + manage managed handlers
- t dient Enabled (system.web/httpHandlers)
] aspret_dlen directly in the configuration file.

DataVerification

ABBYY FlexiCapture WebService =dl Enabled Unspedified IsapiModu
F!j’“:;“;:;gers ASPClassic = asp Enabled File IsapiModu _
=] ADE:Themes AXD-ISAPI-2.0 *axd Enabled Unspedfied IsapiModu Add Script Map...
| bin AXD-ISAPI-2.0-5% =axd Enabled Unspecified IsapiModu Add Wildeard Saript Map...
| CustomReports CGl-exe =exe Enabled File CgiModule Add Module Mapping...
| Help HttpRemotingHandlerFactor y-rem-ISAPI-2.0 *.rem Enabled Unspedified IsapiModu
1 Images HttpRemotingHandlerFactoryrem-ISAPL-2.0-64  =rem Enabled Unspecified IsapiModu B e

% Reports HttpRemotingHandlerFactory-soap-ISAPI-2.0 *.508p Enabled Unspedfied IsapiModu R
Server

HttpRemotingHandlerFactory-soap-1SAPI-2.0-64  <.s0ap Enabled Unspedified IsapiModu View Ordered List...
ISAPL-dIl =dll Enabled File IsapiModu @ Help
OPTIOMSVerbHandler = Enabled Unspedified ProtocolSy Online Help
PageHandlerFactory-ISAPI-2.0 *aspx Enabled Unspecified IsapiModu
PageHandlerFactory-ISAPI-2.0-64 *aspx Enabled Unspecified IsapiModu

SecurityCertificate =.cer Enabled File IsapiModu
SimpleHandlerFactory-ISAPI-2.0 *ashx Enabled Unspecified IsapiModu
SimpleHandlerFactory-ISAPI-2,0-64 *,ashx Enabled Unspedified IsapiModu

SSINC-shim *shtm Enabled File ServerSide

SSINC-shtml =shtml Enabled File ServerSide

SSINC-stm *.stm Enabled File ServerSide

StaticFile = Enabled File or Folder StaticFilel

TRACEVerbHandler = Enabled Unspedified ProtocolSy
WebServiceHandlerFactory-ISAPI-2.0 = asmx Enabled Unspecified IsapiMadu
WebServiceHandlerFactory-ISAPI-2.0-64 *asmx Enabled Unspecified IsapiModu

Wil e | Enabled File IsapiModu—I

| | LILI

q || ] oo

Configuration: ‘Default Web Site/FlexiCapture 10/Server' web. config ei .

For correct operation of the Application Server, the installer creates a mapping «ABBYY FlexiCapture WebService» with the

following parameters:
Request path = «*.dll»

Executable = «C:\inetpub\wwwroot\FlexiCapture1 0\Server\WebServicesIsapi.dll»

-
Edit Script Map — —_

Request path:
=dll

Example: *.bas, wsvc.axd

Executable:
Chinetpubwwwroot\FlexiCapturel0\Server\WebServiceslsapi.dil E]
N
ABBYY FlexiCapture WebService
| |
Request Restrictions...
i OK l [ Cancel i
H |

Access = «Script» («Scripts and Executable» on IIS 6)
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Request Restrictions ] -3
Mspping [ Verbs | Access |

Specify the access required by the handler:

) None
) Read
) Write
@ Script

) Execute

0K l [ Cancel

b

Note: It may happen that a third-party application is installed on the same computer as the Application Server, and it can intercept
requests of ABBYY FlexiCapture 10. In this case, the following error message will occur when starting the Administration and

Monitoring console:

A runtime error occurred:
Cannot get file storage path
Details:

Description Client found response content type of 'text/html; charset=utf-8', but expected 'text/xml'. The request failed with the
error message: -- Server Error in Application "DEFAULT WEB SITE/FLEXICAPTURE10/SERVER"Internet Information Ser-

vices 7.5
Error Summary
HTTP Error 500.0 - Internal Server Error

There is a problem with the resource you are looking for, so it cannot be displayed. Detailed Error InformationModule IsapiMo-
dule

Notification ExecuteRequestHandler

Handler Custom Handler

Error Code 0x8007007f

Requested URL http://127.0.0.1:80/FlexiCapture10/Server/WebServices.dll?Handler=Default
Physical Path C:\inetpub\wwwroot\FlexiCapture10\Server\WebServices.dll

Logon Method Negotiate

Logon User WORKGROUP\WIN-COSLCUOARGAS

In this case, a handler which intercepts the request to the Application Server is called Custom Handler.
ISAPI and CGI Restrictions

The installer of FlexiCapture10 servers creates an allowance for the ISAPI-extension of the Application Server.

To view the list of allowed ISAPI-extensions, at the upper level of the IIS Manager console (the level of IIS server) select ISAPI
and CGI Restrictions.
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ETj Internet Information Services (IS) Manager _ - — —_———

@U [€3 v Zvuznan »

Eile  View Help

Connections - .. CEITTE
Gg' ISAPI and CGI Restrictions ;

ICE

“7d Z,VUZ[NAN (_FINE\HY‘JZ‘”J Use this feature to specify the ISAPI and CGI extensions that can run on the Web server.
L2 Application Pools

4|8 Sites Group by: Ne Grouping @

440 Default Web Site

e Description Restriction Path
7| aspnet_client
N @ Capture Active Server Pages Allowed CAWindows\system32iinetsniasp.dil
© g DataVerification ASP.NET v2.0.50727 Allowed ChWindows\Microsoft, MET\Framework\v2.0.50727\aspnet_isapi.dil
[P FlexiCapture10 ASP.NET v2.0.50727 Allowed CA\Windows\Microsoft. MET\Framework64'w2.0.50727\aspnet_isapi.dIl
7] App_Browsers ASP.NET 4030319 Allowed C\Windows\Microsoft NET\Frameworkivd.0,30318\zspnet_isapi.cll
f ! 5.1 App_Themes ASP.NET v4.0.30319 Allowed Ci\Windows\Microsoft NET\Frameworkid\v4.0.30319\ aspnet isapi.dIl
: i FlexiCapture 10 Web Services Allowed Chinetpub\wwwroot\FlexiCapturel 0\Server\WebServiceslsapi.dil
WebDAV Allowed CAWindows\systerm32\inetsniwebdav.dll

Scanning

(=1 Features View | I3 Content View

Configuration: 'localhost' applicationHost.config g:

«FlexiCapture 10 Web Services» extension (path «C:\inetpub\wwwroot\FlexiCapturel0\Server\WebServicesIsapi.dll») must be
allowed.

-

,
Edit ISAPI or CGI Restriction 2 [
[SAPT or CGI path:
[Cinetpub\wwwrooth FledCapturel 0 Server\WebServiceslsapi.dl E]
Description:
FlexiCapture 10 Web Services

Allow extension path to execute

OK ] l Cancel

Checking the operation of 1I1S

To check the operation of TIS, start IIS by selecting Start=>Control Panel> Administrative Tools=> Internet Information Ser-
vices. If a problem occurs when starting IS, the following message will be displayed: “Unexpected error 0x8ffe2740 occurred”
for v. 5.1 (Windows XP) or “The process cannot access the file because it is being used by another process” for v. 6.0 (Windows
2003), v. 7.0 (Windows 2008) and v. 7.5 (Windows 2008 R2).

This error message means that port 80 is in use. To find out which application is using the port, do the following:

1. Inthe command line (Start=>Run), type
netstat -anop TCP|find ":80"
The list of connections to port 80 will be displayed and the ID of the corresponding process in the following format:
TCP 0.0.0.0:80 0.0.0.0:0 LISTENING 1264
2. Type
tasklist /SVC /FI "PID eq 1264"

replacing 1264 with the ID of the process obtained at step 1. The result will be displayed in the following format:
Image Name PID Services

Virus.exe 1264 KillMePlz
3. End the process that uses the port.

Important! Do not switch IIS over to another port, as you will not be able to start the Application Server in this case.

Working over https

To ensure safety, you can use https protocol. For this, you need to enable SSL support in IIS settings.
To work with IIS over HTTPS protocol, you need to obtain a certificate for the server and connect it.
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Managing certificates
To open the Certificates control panel, do the following:
1. Run Microsoft Management Console. For this, open Start->Run menu, type “mmc” and press Enter.

'fiii Consolel - [Console Root] =10 x|

Bﬁ] File Action Wiew Fawvorites  wWindow  Help _|5’|5|
= ||m B @

Marme |

There are no items ko show in this view,

2. In the console that opens, choose File->Add/Remove Snap-in. in the window that opens, click Add and from the list of
available modules choose Certificates. Click Add.

Add Standalone Snap-in d |

fyvailable standalone snap-ins:

Snap-in | Yendaor | -
ﬂ MET Framework 1.1 Configuration  Microsaft Corporation
ﬂ MET Framework 2.0 Configuration  Microsaft Corporation

ﬁ.ﬂ.ctivex Conkrol Microsoft Corporation (.
‘Cerkificates Micrasoft Carporakion
@Cumpunent Services Microsaft Corporation
QCDmputer Managernenk Microsaft Corporation
Device Manager Microsoft Corporation
@Disk Defragmenter Microsoft Caorp, Execut, .,
gDisk Management Microsoft and VERITAS. ..
Event Wigwer Microsoft Corporation j

—Descripkion
The Certificates snap-in allows vou to browse the conkents of the
cettificate skores for wourself, a service, or a compuket,

Add Close

3. In the window that opens, choose “Computer account” and click Next. In the next window, choose Local Computer and
click Finish.

4. Add the certificate to the Personal folder. On Windows XP, you can obtain a certificate in the following ways:

e Import an existing certificate from file. For this, choose Action -> All Tasks -> Import and specify the path to the
certificate file.

e  Request a certificate from the domain Certificate Authority (provided that Certificate Authority is a part of do-
main). For this, choose the menu item: Action -> All Tasks ->Request new certificate, in the certificate type, speci-
fy “Computer”, then specify the name of the certificate.

e  You can also obtain a certificate from an online Certificate Authority (e.g. a free certificate can be obtained at
WWW.CACEIL.OLg).
Connecting certificate in IIS on Windows XP
1. On the IIS Manager panel, open the Default Web Site properties dialog box.
2. In the Secure Communications section of the Security tab click “Server Certificate...”
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3. In the window that opens, choose a certificate to be used by the server.

Default Web Site Properties

HTTF Headers I Cuztom Errors I ASFPMET I Server Extenzions
“wWieh Site I ISAP] Filkers I Haome Directony I Docurnents Directory Security

2%

—Anonymouz accezs and authentication contral

! ; Enable anonymous acceszs and edit the

= =5

authentication methods for thiz rezource. Edit

r |F addresz and/domain name restrctions

[Framnt o deny access to this resource wsing
|F addreszes on internet domait fames.

Edit...

— Secure communications

R equire secure communications and

enable client certficates when thiz
[E20LICE i§ Accessed,

Wi Certificate...

Edit...

(] Cancel Apply

Help

After you choose a certificate, you can enable the option which allows only https connections to the Internet for a selected site or

for Default Web Site. For this:
1. Open the Security tab of the site properties.
2. In the Secure Communications section click Edit.
3. In the window that opens select the option “Require secure channel (SSL)”.

© 2011 ABBYY. All rights reserved.
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1.
2.

Secure Communications

—Iv Require zecure channel [S5LE

[ Require 128-bit encryption

— Chent certificates

' |gnore client certificates
™ Accept client certificates
™ Require client certificates

client certificates.

[” Enable client certificate mapping

Client certifizates can be mapped to ‘Windows user
accountz. Thiz allows access control to rezources uzsing

Edi... |

[T Enable certificate trust list

Lurrent CTL: I

Wew. | Edi. |
| F, I Cancel | Help |
Connecting certificate in IIS on Windows 7
In IIS settings, connect HTTPS protocol for Default Web Site. For this:
Run IIS Manager Console from the Control Panel.
Choose Default Web Site and on the Actions panel, click the Bindings link.
W= Internet Information Services (M%) Manager [=]
g
% [€@ » PAVLOV_WINT » Sites » Default Web Site » & < M @ -
Eile View Help
Connections Actions
re Default Web "
A . g Explore s
495 PAVLOV_WINT (PAVLOV_WIN Site Home Edit PEne e
Y ,-x.ppllcatlcun Pocls Filter: . Edit Site
4- @ Sites ||
4 € Default Web Site ASP.NET = b i)
s - | aspnet_client 1= &:‘__, |E| B Basic Seffings..
> -[2¥ FlexiCapture % N B View Applications =
NET NET View Virtual Directories
Authorizat.,, Compilation
N - Manage Web Site Al
G e Restart
MET Errar MET P Start
Pages Glohbalization B Stop i
F\_ 'g 1,\/‘. Browse Web Site
e il Browse =80 (http)
MET Profil .MFT Rriles —
e ne Browse *:443 (https)

1 | 1 3

Ready

| Features View |._;_ Content Wiew

Advanced Settings...
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3. Inthe dialog box that opens click Add and select “https” protocol from the “Type” drop-down list.
4. From the “SSL Certificate” drop-down list, select a desired certificate and click Ok.

Add Site Binding [~ B[]

Type: IP address: Port:
hittps = | All Unazzsigned + 443

SEL certificate:

test - ‘ | View...

| ok || cancad |

5. If you want the site to be available via https only, then choose it in the tree of sites, open SSL Settings and select the op-
tion «Require SSL».

Note: Verification of client certificates is not performed, so when configuring SSL, set the value of the «Client certificates» op-
tion to Ignored.

Switching system components to 64-bit mode

Important! This configuration is not recommended (e.g., pool of the Application Server (FlexiCapture 10 Web Services) does not
work in 64-bit mode). In particular, when using Oracle as a database server, the Oracle client through which a connection to the
database is performed must work in the same bit mode as both the pool of Administration and Monitoring console (FlexiCapture
10 Monitoring) and the pool of Application Server. If you switch the pool of Administration and Monitoring console to 64-bit
mode, it will work in a different mode than the Application Server pool (which works in 32-bit mode). A possible solution is to
install two identically configured Oracle clients one of which works in 32 bit mode and the other in 64 bit mode.

You may need to switch the pool of Administration and Monitoring console to 64-bit mode if you are using Crystal Reports x64
(a tool for generating reports), Tak Kak UX pa3psaHOCTB JOIDKHA COBIIAJATh, a Mcnonb3oBanue Crystal Reports x32 HEBO3MOXKHO.
By default, the pool of the Administration and Monitoring console works in 32-bit mode. To switch it to 64-bit mode, do the fol-
lowing:

1. Open IIS Manager Console: Start -> Administrative Tools -> Internet Information Services (IIS) Manager.
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™E Internet Information Services (IIS) Manager = 1ol |
@@ | €3 » win-cosicuoarcA > | & = 5@ -

c;! WIN-COSLCUOARGA Home

Manage Server
= Restart
Filter: - % Go - % Show All | Group by:
l || start
ASP.NET o
I— B Stop
1-48) Default Web Site .‘E& \\\f«\% ,0 9 View Application Paols
= > LE]] L
NET NET {NET Error NET MNET Trust Ve 322
Authorizati... Compilation Pages Globalization Levels @ Help

) ;‘? | », Online Help
@i’l = |%?)

Application Connection  Machine Key  Pages and Providers
Settings Strings Controls

& (&

Session State  SMTP E-mail

2 @ 9 o

Authentication CGI Compression Default

Document

Directory Error Pages FastCGI Handler HTTFP j
1| » @ Features View r__E‘ Content View
Ready &

2. Choose Application pools.

?E Internet Information Services (IIS) Manager ;Iglil
@—@ [Q » WIN-COSLCUOARGA * Application Pools J < e -

ﬂ,' H |ﬁ |& e;! Appllcatlon Pools ,L; Add Application Poal...

€5 Start Page Set Application Pool Defavits
qu WIN-COSLCUOARGA (WIN-COSLCUDARG This page lets you view and manage the list of application pools on the = A
= e server. Application pools are assodated with worker processes, contain one Application Pool Tasks
-} Application P or more applications, and provide isolation among different applications.
Sites P Start
Defauit Web Site Filter: -| (0G0~ (55 Show Al | Group by: 2 || ® st
:_—; aspnet_.dlem.: MName = | Status | .MET Framewor... | Managed g Recyde. ..
4 Dla‘a_"'e”ﬁa“"” 20 Classic .NET AppPool Started  v2.0 Classic o .
=¥ FlexiCapture1d 2} DefaultappPool Started w20 Integrate it Apg
[E}FlexiCapture 10 Monitoring ~ Started  v2.0 Integrate Basic Settings...
QFIexiCapmre 10 Web Services Started No Managed Code  Classic Recyding...
Advanced Settings...
Rename
x Remove
View Applications
@ hep
Online Help
< ]
Ready &

3. From the list of pools, choose FlexiCapture 10 Monitoring and in the Actions menu, select Advanced Settings...
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B {General) =
MET Framework Version w2.0
Enable 32-Bit Applications [False |
Managed Pipeline Mode Integrated
MName FlexiCapture 10 Monitoring
Queue Length 4000
Start Automatically True

= CPU
Limit u]
Limit Action MoAction
Limit Interval (minutes) [1]
Processor Affinity Enabled False —
Processor Affinity Mask 4294967295

E Process Model
Identity MetworkService
Idle Time-out (minutes) 20
Load User Profile False
Maximum Worker Processes 1
Ping Enabled True
Ping Maximum Response Time {seconc 90
Ping Period (seconds) 30
Shutdown Time Limit (seconds) a0
Startun Time |Limit {fearnnde) an ht

Failure Interval (minutes)

[rapidFailProtectionInterval] The time interval {in minutes) during which the spedfied
number of worker process crashes (Maximum Failures) must occur before the
application poal is shut down by Rapid Fail Protection.
Ok Cancel |
A

The value of Enable 32-Bit Application parameter must be False. It means that the Administration and Monitoring console
works in 64-bit mode.

In addition, check if using of 64-bit version of ASP.net is allowed in IIS settings. For this, open the IIS Manager console and
choose the IIS server. From the menu on the right, select ISAPI and CGI Restrictions.

g Internet Information Services (IIS) Manager o =] 3|
@‘)f [93 } WIN-COSLCUOARGA * &l < @ -
Fle Vew Hep
- @3 WIN-COSLCUOARGA Home
€-H |2 |8 L Manage Server
----- 'd5 start Page = 2 Restart
& g; RS | * (o - Gshon Al |Groupby: Area - & ‘; ;5( y
! =
i} Application Pools ASP.NET = B s
Bl Sites ~ £
B@ Default Web Ste ;5% 3\; [¥7 9 L il‘r}? View Applcation Pools
| aspnet_cient NF = # view
¥ Dataverification NET NET NET Error NET MNETTrust  Applcation  Connection  Machine Key ikl
Authorizati... Compiaton  Pages  Globaization  Levels Settings Strings @ Hep
= 3 Oniine Help
e [+
=] d g@’ [ |
Pagesand  Providers  Session State  SMTP E-mai
Controls
s
2 &R g (e
asp Authentication Avuthorization car Compression Default Directory  Error Pages
Rules Document Browsing
e B {; =
@3 ?g %, ﬁ”
FastCGI Handler HTTR 1P Address  {T5EET and GG} ISAPI Filters Loaging MIME Types
Settings ~ Mappings  Respo...  andDom... _Restrictions
éﬂ F = Al @ty
Modules Output Request Server Worker
Caching Fitering ~ Certificates  Processes
Management
iR o8 8w :
=" Y D =
Configuration  Feature  ISManager ISManager Management  Shared =
Al | v| |[Features view |\ Content View
Ready 9

Allow using ASP.NET v2.0.50727 for Framework 64-bit (path C:\Windows\ Microsoft. NET\ Framework64\ v2.0.50727\ asp-
net_isapi.dll)
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E Internet Information Services (T15) Manager P [l
@ ‘> [ € » WIN-COSLCUDARGA » I & 0@ -
File View Help
@30 ISAPI and CGI Restrictions
€-H |7 |8 ? Add...
5 Start Page
5 WIN-COSLCUDARGA (WIN-COS| Use this feature to specify the ISAPT and CGI extensions that can run on the Web server, Edit Feature Setiings...
i) Application Faols Group by: Mo Grouping - @ rep
Site:
- ;— é Do Web Stz |Bescane [ Restriction [ path Online Help
aspnet. dient [No Description] Alowed C:\Program Files (x86)\ABEYY FlexiCapture 10 Servers\Controllers.dl
% Dataverification Active Server Pages Alowed C:\Windows\system32ynetsry\asp.dl
-9 FlexiCapture 10 {ASP.NET v2.0.50727 Alowed C:\Wi licrosoft. NET\Frameworks4w 2.0. 50727 \aspnet_isapi.dl
“| App_Browsers ASP.MET v2.0.50727 Allowed C:\windowsWMicrosoft. NET\Framework\v2.0.50727\aspnet_isapi.dll
| App_Themes FlexiCapture 10 Web Services Allowed C: t\FlexiCapture 10\Server \WebSer i
bin
CustomReports
Help
_| Images
| Reports
[ server
4 [ |
ol | v [=Features View |\ Content View
Configuration: localhost’ applicationHost. config 6.

Database server

SQL

* For the Application Server to work, MS SQL Server version 2005 SP2, 2008 SP1 or 2008 R2 is required. On the server, the
"Mixed Mode" ("SQL server and Windows authentication") must be enabled for authentication. The installation CD contains MS
SQL Server 2005 Express. It can be used for demonstrative purposes and small projects. This version has a limitation on the data-

base size of 4GB. If you already have an installed copy of MS SQL Server 2005 or 2008, you can use it.
Oracle

* Instead of SQL Server, the Oracle Server 10g or 11g can be used as a database server. For this, a 32bit client for the Oracle data-

base must be installed.

Important! By default, an Oracle database allows a maximum of 40 processes and 49 sessions. When these limits are reached,
the following error message occurs: “ORA-12516: TNS:listener could not find available handler with matching protocol stack”.

If required, increase the default values by using a script similar to the following:
connect sys/<Login> as sysdba;

alter system set sessions=<SessionCount> scope=spfile;

alter system set processes=<ProcessCount> scope=spfile;

shutdown immediate;

startup;

Interaction of the system components

The following figure displays the system component interaction for distributed installation:
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So the following ports have to be enabled:

TCP 10021

.  Application Server— 80 if HTTP is used or 443 if HTTPS is used

«  Processing Server — 10020
. Licensing Server — 10040
. Processing Station — 10021

Note. It is recommended that you should disable the iPv6 protocol in the adapter properties, otherwise addresses of the hosts are

not displayed correctly in the Administration and Monitoring Console.

Installing the stations

The following installation methods are available to install the stations:

. manually (interactive installation)
.  from the command line

. using Active Directory

. using Microsoft Systems Management Server (SMS)

The automated installation methods give you speed and flexibility when installing ABBY'Y FlexiCapture 10 on a local area net-

work, as you do not have to install the program manually on each individual workstation.

Manual (interactive) installation
To install ABBYY FlexiCapture stations:

1. In the Autorun menu, select Distributed Installation.

2. Select Install Workstations to start the installation.

3. Select a setup language. The setup program will compare the locale of your system and the selected language. If the lan-

guages are incompatible, a warning message is displayed.
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4.  Next, the setup program checks the version of your operating system and the availability of the administrative permis-
sions. If the version of the operating system is not supported by the program or you do not have the administrative per-
missions, a warning message is displayed and the setup program is terminated.

5. If all the checks are passed successfully, the end-user license agreement will be displayed. Read the license agreement
carefully and if you agree with the terms of the agreement, select the corresponding option and click Next.

6. A dialog box will open prompting you to enter some information about yourself. Enter the required information and con-
tinue with the installation.

7. Next, select a destination folder. By default, the program is installed to: % systemdrive%\Program Files\ABBYY
FlexiCapture 10 Stations

8. Select the stations to install:
«  Scanning Station scans documents and sends them to the server for further processing
.  Processing Station automatically recognizes, imports, and exports documents; controlled by the Processing Server
«  Project Setup Station is used to set up projects on the server and local projects
. Data Verification Station is used to verify uncertainly recognized characters
. Verification Station is used to verify data, correct document assembly errors, handle exceptions
«  FlexiCapture Studio is a tool for creating FlexiLayouts

.  FormDesigner is a tool for creating forms
Just like the servers, the stations can be installed on the same or on different computers.

9. Ifa Processing Station is selected, a dialog box will appear where you must select the account under which the
Processing Station service will run. By default, the service runs under the user NETWORK SERVICE. If you plan to
import/export data on this station from/to a storage location with restricted user rights, or if this station is not in the do-
main, you can specify the user that has the appropriate rights. In this case, the Processing Station service will run under
this user.

10. The program files will be copied onto your computer. Once the installation is finished, the setup program will display a
message saying that the application has been successfully installed.

11. If FlexiLayoutStudio, FormDesigner, Verification or Project Setup Station is installed, provide the address of the
Protection Server in the next dialog box. The Protection Server is installed via server installation. The address should not
contain slashes, for example: MainServer

Command line installation

In the default configuration, all recognition languages are installed on the local computer and the interface language is selected
automatically based on the regional settings of the computer on which the program is installed. All stations are installed, and the
network name of the computer from which the setup program is run is used as the Protection Server (in the case of standalone
installation, “localhost™ is specified). The default user becomes the user of the Processing Station.

Run the setup.exe file located in the administrative installation folder using the command line options described below.

Advertise installation
For advertise installation, type
Setup.exe /j

The program icon will appear in the Start menu of the workstation. Clicking this icon automatically installs the program in de-
fault configuration.

Silent installation

In the case of silent installation, no setup dialog boxes are displayed and the program is installed in default configuration.
Setup.exe /qn

Change “/qn” to “/qb” if you want an installation progress bar to be displayed.

No other dialog boxes will be displayed.

Additional command line options

/L<language code> disables auto selection of the interface language and installs the program with the interface language you spe-
cified.

The following language code values are available:
1033 English
1049 Russian
1031 German
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1036 French

2052 Chinese simplified
1040 Italian

1034 Spanish

2074 Serbian

1029 Czech

1038 Hungarian

1045 Polish

1046 Portuguese (Brazilian)
1042 Korean

/V <command line> passes the specified command line directly to msiexec.exe. The <command line> string can be replaced with
the following commands:

INSTALLDIR="<destination>" — the path to the folder where ABBY'Y FlexiCapture 10 is to be installed.
STATIONS=0,1,2,3,4,5,6 — the list of stations to install.

The numbers 0 to 6 correspond to the following stations:

0 — Scanning Station

1 — Processing Station

2 — Verification Station

3 — Data Verification Station

4 — Project Setup Station

5 - FlexiLayout Studio

6 - FormDesigner

ACCOUNTTYPE=Custom, LOGIN=user name, PASSWORD=password

You can specify an account under which to run the Processing Station service.

Example:

Setup.exe /qn /L1049 /v INSTALLDIR="D:\FC10" STATIONS=1,4 ACCOUNTTYPE=Custom
LOGIN=Domain\UserLogin PASSWORD=PSWD

As a result, the Processing and Project Setup Stations will be installed into D:\FC10, and Russian will be used the language of the
interface. The Processing Station service will run under the account Domain\UserLogin and the password will be PSWD.

PROTECTIONSERVER=ServerName — the name of the protection server.
Removing ABBYY FlexiCapture in silent mode
msiexec /x {FC10000C-0001-0000-0000-074957833700}

Using Active Directory

Microsoft© Windows© 2000 Server and later include an integrated directory service, Active Directory, which in turn includes
Group Policy. The Software Installation snap—in, which is part of Group Policy, allows you to install a software application on
several workstations simultaneously.

Three major installation methods are implemented in Active Directory: Publish to User, Assign to User, and Assign to Com-
puter. ABBYY FlexiCapture 10 can be installed using the Assign to Computer method. ABBYY FlexiCapture 10 will be in-
stalled on the specified workstation after the workstation is restarted.

The Publish to User and Assign to User methods are not supported.

When deploying ABBYY FlexiCapture 10 using Active Directory®, the account of the computers in the Domain Computers
domain must have read right to the administrative installation folder.

Example: Deploying ABBYY FlexiCapture 10 using Active Directory

The program is installed on one domain computer or on a group of domain computers:

1. During Server Installation, install the Station Installer. If you did not install the Station Installer when installing the Ap-
plication Server, install the Station Installer by selecting Control Panel>Add or Remove Programs—> Change.

2. Select Start->Control Panel> Administrative and then select the Active Directory Users and Computers item.
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¢ Active Directory Users and Computers
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3. Right—click the site, domain, or another organized unit that contains the computer or group of computers onto which
ABBYY FlexiCapture 10 is to be installed.
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4. On the shortcut menu, select Properties and click the Group Policy tab:
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Click New, enter a descriptive name, and click OK.

Right-click the Group Policy Object you have created and select Edit...

In the Group Policy window, right-click Computer Configuration/Software Settings/Software Installation.

On the shortcut menu, select New/Package.

‘i Group Policy Object Editor

File  Action  Wiew Help

=100 x|

@ Computer Configuration
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Package... |
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Help

|Creates a new object in this container,
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9.  Provide the path to the file ABBYY FlexiCapture 10 Stations.msi, which is located in the administrative installation

folder on the server.

10. Select the Advanced deployment method.

e X

Select deployment method:
" Published
" Assigned
& ddyvanced

Select thiz option to configure the Publizhed or Azsigned optionz,
and ta apply rodifizations to a package.

(] I Cancel |

11. In the dialog box that opens, click the Modifications tab and then click the Add button.
ABBYY FleriCapture 8.0 Professional Properties e Bt

General Depln:n_l,lmentl Upgrades | Categaries  Modifications | Sec:urit_l,ll

todifications or transforms allow wou to customize the package and are
applied to the package in the order shawn in the following list:

Modifications:

fave llp |

felmwe [0 o

Bemove |

Important! Do not prezs OF, until all tranzforms are added and ordered
corectly. Faor mare information, right-click on the Modifizations list box, and
then click What's this?

aF. Cancel

12.  Select the interface language to be used in ABBY'Y FlexiCapture 10. The language files are located in the administrative

installation folder on the server.

The list of available files and their corresponding languages:
1033.mst English

1049.mst Russian

Using SMS

Microsoft Systems Management Server automates software deployment and eliminates the need to go directly to the locations

where the software is to be installed (computers, groups, or servers).
SMS deployment includes the following three stages:

1. Creating an ABBYY FlexiCapture 10 deployment package.
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2. Creating a deployment script (contains installation parameters: names of computers, time of installation, conditions for
installation, etc.).

3. Deployment of the program on the workstations by SMS based on the script settings.

Example: Deploying ABBYY FlexiCapture 10 using Microsoft SMS
1. When installing the Application Server, create an installation package for ABBY'Y FlexiCapture 10 stations.
2. Inthe SMS Administrator console, select the Packages node.

3. Inthe Action menu, select New/Package.

‘i'm sms - [Systems Management Server] = | (= ﬂ

File  Action Miew Help
-~ m&aB| 2

E iSystems Management Server | EEIE I
EC@ Site Database (001 - Abbyy) Site Database (001 - Abbyy)

- Site Hierarchy
[]-- Collections

Cﬂ Adver OPEN |

D"% Repot ™ nllTasks b Package From Definition

-0 Querin  Prnt
@ Softw  Refresh

Sacir] Properties
- Tonls Help
Onlines e

|Se|ect this item to create a new SMS Package.

|
i/ start J @ @ J n& sms - [Systems Mana... J | g &a)ij 15:09

4.  In the Package Properties dialog box, fill out the required fields.

© 2011 ABBYY. All rights reserved.
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o N W

ABBYY FlexiCapture 9.0 English Package Properties

Digtribution Setings I Reparting I

General

[ata Source I [ata Access

ﬁ' I.-‘-‘-.EHBW FleriCapture 9.0 Englizh

Change |zor.... |

2%

Security

M arne;
Werzion;
Publigher:
Language:

LComment;

IﬁB B

IEninsh

k. I Cancel Spply

Help

Click the Data Source tab.

Make sure that This package contains source files is cleared and click OK.

Expand the node of the newly created package and select Programs.

In the Action menu, select New/Program.

© 2011 ABBYY. All rights reserved.
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ABBYY ABEYY FlexiCapture 8.0 English
"t Acress Accounts
Distribution Points

Open |

Program

View r

Print
Refresh
Export List. ..

Help

Name

| Run Tirne (hh:rom} |

Disk Space | Comment

There are noitems ko show in this view,

|Creates a new object in this container.

Lt.’Startl J 28

J B My Docurnents

”nﬁ sms - [Systems Mana... w untitled - Paink

9. Inthe Program Properties dialog box, click the General tab and on this tab:

. Inthe Name field, type a descriptive name of the program

«  Inthe Command Line field, type setup.exe /q

i o e 22

o In the Start in field, provide the network path to the ABBYY FlexiCapture administrative installation folder (e.g.
\\MyFileServer\Programs Distribs\ABBYY FlexiCapture 10).

10. In the Program Properties dialog box, click the Environment tab and on this tab:

o Clear the User input required option

o Select the Runs with administrative rights option

«  Make sure that the Run with UNC name option is selected

11.  Adjust the running parameters if required and click OK.

12.  You can also use the Distribute Software Wizard. In the Action menu of the package, select Distributive Software
and follow the instructions of the wizard.
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Distribute Software Wizard x|

Welcome to the Distribute Software
Wizard

Thiz wizard helps you digtibute software to clients.

Y'ou can select ar create a software package and copy the
package to distnbution points on your netbwork.

f'ou can then advertize a program to collections that clents
are members of, or create a new collection to advertize the
pragrar ko,

To distribute softweare, click Mest.

< Back

Cancel |

Important! You cannot create Distribution Points.

Installing Remote Stations

Using Remote Stations allows you to connect to the Protection Server from the computers which are not part of the LAN. Remote
Stations include the Data Verification and Scanning stations. The Verification station can be both regular and remote.

Remote Stations can connect to the Application Server via HTTP.

To install Remote Stations:

1. Select Distributed Installation.

2. Select a menu item corresponding to a station to be installed.

3. Select a setup language. The setup program will compare the locale of your system and the selected language. If the lan-
guages are incompatible, a warning message is displayed.

4. Next, the setup program checks the version of your operating system and the availability of the administrative permis-
sions. If the version of the operating system is not supported by the program or you do not have the administrative per-
missions, a warning message is displayed and the setup program is terminated.

5. Ifaall the checks are passed successfully, the end-user license agreement will be displayed. Read the license agreement
carefully and if you agree with the terms of the agreement, select the corresponding option and click Next.

6. A dialog box will open prompting you to enter some information about yourself. Enter the required information and con-
tinue with the installation.

7. Next, select a destination folder. By default, the program is installed to: %systemdrive%\Program Files\ABBYY
FlexiCapture 10 <Station>\. If there is not enough space on the selected hard disk, a window is displayed showing your
hard disks, the available free space, and the space required by the installation. Select a disk with sufficient free space and
continue with the installation.

8. The program files will be copied onto your computer. Once the installation is finished, the setup program will display a
message saying that the installation has completed successfully.

IMPORTANT!

1. The Application Server should be published to the Internet if you wish to use the remote stations over the Internet.

2. The Processing Server should be started to use remote stations.

3. Basic-authentication should be enabled in IIS in the Default Web Site\FlexiCapture10\Server folder to use such authen-

tication type when connect to the Application Server.
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Upgrading from ABBYY FlexiCapture 9.0

If you are installing ABBY'Y FlexiCapture 10 as an upgrade from version 9.0 you can use ABBYY FlexiCapture and ABBYY
FlexiLayout projects as well as FlexiLayouts from the previous version.

Using ABBYY FlexiCapture 9.0 Professional projects (*.fcproj)

All ABBYY FlexiCapture 9.0 local projects (.fcproj) can be opened and used in ABBY'Y FlexiCapture 10. Please note the follow-
ing:

- It is impossible to open an .fcproj-project in ABBY'Y FlexiCapture 9.0 once it was opened in ABBYY FlexiCapture 10,
so you should create a copy of the project before opening it in ABBYY FlexiCapture 10 if you still need to open it in
ABBYY FlexiCapture 9.0

- After opening ABBYY FlexiCapture 9.0 project in ABBY'Y FlexiCapture 10 you may need to delete all processing re-
sults and analyze all pages once again. (You can use the project without re-recognizing but some information may be
presented improperly, for example if the FlexiCapture 9.0 project contains format errors, they will not be presented in
the document window the same way they are currently presented in ABBY'Y FlexiCapture 10).

ABBYY FlexiCapture 9.0 network projects that were loaded on server can also be used in ABBY'Y FlexiCapture 10.

Important! Both database and a project will be converted to new format and it will be impossible to use them in ABBYY Flex-
iCapture 9.0 again.

If you need to have a Database backup or to work with both ABBY'Y FlexiCapture 9.0 and ABBYY FlexiCapture 10 databases at
the same time please follow the instruction below. If it is not necessary go to the 1-st item of the instruction about upgrade.

To create a Database backup:

- Create a FlexiCapture 9.0 Database backup by MS SQL Server means.

- Create a copy of FileStorage (if it is a folder on a disk) and save it in an appropriate place.
To connect ABBYY FlexiCapture 9.0 to the backup Database:

- Restore the Database from the backup

- Specify path to the File Storage in the FlexiCapture 9.0 Administration and Monitoring Console.
To create a Database copy for ABBYY FlexiCapture 10:

- Copy a FlexiCapture 9.0 Database and rename it (for example, to FC10Database)

- Copy a File Storage folder and rename it (for example, to FC10FileStorage)

- After installing ABBYY FlexiCapture 10 connect to the new database (here FC10Database) and specify the path to the
File Storage folder (here FC10FileStorage)

- Continue working with the original FlexiCapture 9.0 database and the File Storage.
To upgrade a network FlexiCapture 9.0 project:
1. Finish processing of all batches in ABBYY FlexiCapture 9.0 if it is possible.
2. Close all opened sessions via the Administration and Monitoring Console.
3. Install ABBYY FlexiCapture 10 (both servers and stations).
4. Make sure that FlexiCapture 9.0 database is not used by FlexiCapture 9.0. For this, do either of the following:
- Remove ABBYY FlexiCapture 9.0 from the computer or

- Delete the Connection String from the Windows registry: find the registry branch
HKEY LOCAL MACHINE\SOFTWARE\ABBY Y \FlexiCapture\9.0\WebServices and delete the “DBConnec-
tionString” parameter

5. Upgrade the database to the necessary version in the Administration and Monitoring Console.

6. Inthe Administration and Monitoring Console, open the Service -> Out-of-Processing page and check if there are any
batches there. If yes, click the Return to processing button to send batches to further processing.

7. In the Project Setup Station, open a project from Server. It will be converted to ABBYY FlexiCapture 10 format.

8. Check if the project and the Document Definition settings are correct. We recommend checking state of the “Process
whole batches” option on the Workflow tab of the Project or Batch type properties window.

9.  Continue working with the project.
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Using ABBYY FlexiLayout Studio 9.0 projects (*.fsp) in ABBYY FlexiLayout 10
All FlexiLayout Studio 9.0 projects can be opened in FlexiLayout Studio 10. Please note the following:
- It is impossible to open an .fsp-project in ABBYY FlexiLayout Studio 9.0 once it was opened in ABBY'Y FlexiLayout
Studio 10, so you should create a copy of the project before opening it in ABBYY FlexiLayout Studio 10 if you still
need to open it in ABBY'Y FlexiLayout Studio 9.0.
- After opening a FlexiLayout Studio 9.0 project in ABBYY FlexiLayout Studio 10 you may need to delete all processing
results and analyze all pages once again.

- Due to changes in FlexiLayout language some compilation errors may occur. In this case you will need to correct errors
and re-compile FlexiLayouts.

Using FlexiLayouts (*.afl) created in ABBYY FlexiLayout 9.0
FlexiLayouts compiled in ABBYY FlexiLayout 9.0 can be loaded into ABBY'Y FlexiCapture 10.

Sometimes due to changes in FlexiLayout language some compilation errors may occur. In this case open the *.fsp project in
ABBYY FlexiLayout Studio 10, correct the errors and re-compile FlexiLayouts.

Upgrading from ABBYY FlexiCapture 8.0 Professional

If you are installing ABBY'Y FlexiCapture 10 as an upgrade from version 8.0 you can use ABBYY FlexiCapture and ABBYY
FlexiLayout projects as well as FlexiLayouts from the previous version.

Using ABBYY FlexiCapture 8.0 Professional projects (*.fcproj)
All ABBYY FlexiCapture 8.0 Professional projects (.fcproj) can be opened and used in ABBYY FlexiCapture 10 (both Standa-
lone and Distributed). Please note the following:
- It is impossible to open an .fcproj-project in ABBY'Y FlexiCapture 8.0 once it was opened in ABBYY FlexiCapture 10,
so you should create a copy of the project before opening it in ABBYY FlexiCapture 10 if you still need to open it in
ABBYY FlexiCapture 8.0.

- After opening ABBYY FlexiCapture 8.0 project in ABBY'Y FlexiCapture 10 you may need to delete all processing re-
sults and analyze all pages once again. (You can use the project without re-recognizing but some information may be
presented improperly, for example if the FlexiCapture 9.0 project contains format errors, they will not be presented in
the document window the same way they are currently presented in ABBY'Y FlexiCapture 10).

- All settings which were not available in ABBY'Y FlexiCapture 8.0 and have appeared in ABBYY FlexiCapture 10 will
have default values. You can change settings, add batch types, set up workflow settings. To find more details about new
possibilities of ABBYY FlexiCapture 10 please read the help file.

Using ABBYY FlexiLayout Studio 8.0 projects (*.fsp) in ABBYY FlexiLayout 10
All FlexiLayout Studio 8.0 projects can be opened in FlexiLayout Studio 10. Please note the following:
- It is impossible to open an .fsp-project in ABBYY FlexiLayout Studio 8.0 once it was opened in ABBY'Y FlexiLayout

Studio 10, so you should create a copy of the project before opening it in ABBYY FlexiLayout Studio 10 if you still
need to open it in ABBYY FlexiLayout Studio 8.0.

- After opening a FlexiLayout Studio 8.0 project in ABBYY FlexiLayout Studio 10 you may need to delete all processing
results and analyze all pages once again.

- Due to changes in FlexiLayout language some compilation errors may occur. In this case you will need to correct errors
and re-compile FlexiLayouts. See Errors which may occur while converting FlexiLayouts.

Using FlexiLayouts (*.afl) created in ABBYY FlexiLayout 8.0

FlexiLayouts compiled in ABBYY FlexiLayout 8.0 can be loaded into ABBY'Y FlexiCapture 10.

Sometimes due to changes in FlexiLayout language some compilation errors may occur. In this case open the *.fsp project in
ABBYY FlexiLayout Studio 10, correct the errors and re-compile FlexiLayouts. See Errors which may occur while converting
FlexiLayouts.

Errors which may occur while converting FlexiLayouts

Sometimes, FlexiLayouts made in ABBYY FlexiLayout Studio 8.0 cannot be compiled in ABBYY FlexiLayout Studio 10, or
errors occur when matching a FlexiLayout.
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If a FlexiLayout cannot be compiled, open the *.fsp project in ABBYY FlexiLayout Studio 10 and check if any of the elements
are invalid and have error description on the Errors tab.

It is also possible that the FlexiLayout is successfully compiled, but some errors occur during matching.

If you have such problems after conversion, please check if it happened due to one of the errors described below.

Please note that some elements may be found in a different way now and the logic of FlexiLayout may slightly change. Test all
FlexiLayouts on your images before using them for recognition.

If you need assistance please contact our Technical Support.

Problem

| Comment

Workaround

A FlexiLayout will not be compiled with the following errors:

The name of an element coincides with a
function’s name that didn’t exist in pre-
vious versions.

Example: in version 8.0 it was possible to
create a text element with a name “RSA”
and reference it using the short name:
RSA.IsNull. This code cannot be com-
piled in ABBYY FlexiLayout Studio 10.

If the element’s name coincides with a func-
tion’s name, it will be considered as a func-
tion’s name in the code. It’s possible to
create an element with the name PageNumb-
er, but it is prohibited to write PageNumb-
er.IsNull (the only possible way is to write
SearchElements.PageNumber.IsNull );

Use the full name of an element.

Example:
SearchElements.RSA.IsNull

If the element had a name which was
allowed in version 8.0 but prohibited in
ABBYY FlexiLayout Studio 10, and
there was a reference to this element
using a short name in the AdvancedCode,
this element will be re-named during
conversion, but the short name in the
AdvancedCode is not changed. So, in the
advanced code, there will be a reference
to the element which doesn’t exist.

In AdvancedCode, the element
should be re-named manually.

The structure like this is now prohibited:

Let e = SearchElements.StaticText1;
e = SearchElements.StaticText2;

As the elements now have user-defined
properties, the elements of the same type are
not considered identical.

Change the mentioned structure as
follows:

Hypothesis e;

e = SearchElements.StaticText1;
e = SearchElements.StaticText2;

Incorrect usage of elements’ short names.
Example:

There are elements: SearchEle-
ments.A.A, SearchElements.A.B, Sear-
chElements.A.C.

In previous versions, it was possible to
use the following structure in the code of
element C: A.B

In ABBYY FlexiLayout Studio 10, such
a structure cannot be compiled. 4 is con-
sidered SearchElements.A.A, but this
element has not a B field.

A conflict may arise when short names are
used. In version 8.0, in case of conflict, the
high-level element was selected. In ABBYY
FlexiLayout Studio 10, the low-level ele-
ment is selected.

Use the full names of elements.

The following errors may occur during layout matching:

Error in element "SearchEle-
ments.StaticText", Pre-search relations
section: D:\Tests\ForConversion\1.txt
was not found.

In ABBYY FlexiLayout Studio 10, a refer-
ence folder for relative paths to the text files
used in the StaticText element was changed.
In version 8.0 the relative path began from
the batch’s folder (where the images are
stored). In ABBYY FlexiLayout Studio 10,
they begin from the project’s folder (the
folder which contains the .fsp file).

Place the mentioned text file to the
folder indicated in the message (for
this example, you should put the file
“1.txt” to the following folder:
D:\Tests\ForConversion\). You can
also change the path to the file.

Upgrading from ABBYY FormReader 6.5

In ABBYY FlexiCapture 10, the structure of projects is different, so the old projects cannot be used as they are. To be able to use
your templates and flexible descriptions created in ABBYY FormReader 6.5, please read the instructions below and take all poss-
ible issues and limitations into consideration.
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Using ABBYY FlexiCapture Studio 1.5 projects (*.fsp) in ABBYY FlexiLayout 10

ABBYY FlexiCapture Studio 1.5 projects can be opened in ABBYY FlexiLayout Studio 10 — no conversion is needed. Please
note the following:

- Once the project is opened in ABBY'Y FlexiLayout Studio 10, it is permanently converted into FlexiLayout Studio 10 format
and can no longer be opened in ABBY'Y FlexiCapture Studio 1.5 after this point. Please make sure you create a backup copy
of all projects for ABBYY FlexiCapture Studio 1.5 before opening them in ABBY'Y FlexiLayout Studio 10. This is a safety
measure useful in the event you still need to open the projects in ABBYY FlexiCapture Studio 1.5.

- After opening a FlexiCapture Studio 1.5 project in ABBYY FlexiLayout Studio 10, you need to delete all processing results
and analyze all pages once again in order to finish converting the project.

Due to the changes in FlexiLayout language, some compilation errors may occur. In this case, you will need to correct errors and

re-compile FlexiLayouts. Please contact our support team if you need assistance. See Errors which may occur while converting

FlexiLayouts.

Using FlexiLayouts (*.afl) created in ABBYY FlexiCapture Studio 1.5

There are numerous changes in ABBYY FlexiLayout Studio 10 as compared with ABBYY FlexiCapture Studio 1.5. That is why
we recommend opening an *.fsp project in ABBYY FlexiLayout Studio 10 first to check that there are no errors, and re-compile
it, even though FlexiLayouts compiled in ABBYY FlexiCapture Studio 1.5 can be loaded into ABBYY FlexiCapture 10. See
Errors which may occur while converting FlexiLayouts.

Importing templates from ABBYY FormReader 6.5 batches (*.frm)

All ABBYY FormReader 6.5 templates can be imported to ABBYY FlexiCapture 10. You must specify from which FormReader
6.5 batches (*.frm) you want to import templates.

Note: Batches created in versions earlier than 6.5 cannot be imported.

Conversion scenario

1. Open the ABBYY FlexiCapture 10 Project Setup Station for Distributed installation or the Administrator Station for
Standalone installation.

2. Create a new project (File > New Project...).
3. Open the Document Definitions window (Project > Document Definitions...)

4. Click Import..., then select FormReader 6.5 Batches (*.frm) from the Files of type: list and browse the FormReader
batch from which you want to import templates.

Open file for import

Look in: | (3 FRESCaDive

9. Cal Dive.Frm

File name: | Cal Drive. Frmn | E:p_en |

Filez aof type: Fn:nrrnFiE-an:Ier L v| [ Cancel ]

On clicking Open, the import will start.
When the import is finished, you will see a window showing the import result with a path to the log file.
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ABBYY FlexiCapture 10 {Project Setup Station)

'T Import completed wikh warnings.
L]

X

Import log skored in File CADOCUME~1\avtorovaiLoC ALS~1 )\ TempiBanking Application Forms_Import_Log.kxk,

The log file contains information about conversion including description of warnings or errors, if there are any.

The imported template(s) will appear in the list of Document Definitions. Open them and check field marking, data
types and validation rules. Both fixed and flexible layouts with fields and their names are imported completely (except
additional fields). All data types are imported as Custom data types of the Document Definition. Some of the validation
rules are converted automatically; the others have to be remade manually. The information about rules’ conversion can
be found in the Compatibility with FormReader 6.5 validation rules table. Tips for converting rules that cannot be im-
ported automatically can be found in the Help File (“Migrating from FormReader 6.5 rules and export to FlexiCapture
10 scripts™).

Export settings are not converted, so you will need to readjust them.

Test the imported Document Definition on the test batches. The images from ABBYY FormReader 6.5 batches are not
imported, you can add them using the File > Load Images... command.

Publish the converted Document Definitions.

Document and batch structure

If the Document Definition imported from ABBYY FormReader 6.5 contains a custom structure which is not supported in
ABBYY FlexiCapture 10, a set of one-page Document Definitions will be imported.

1.
2.
3.

Document templates with predefined structure (one-page document, multi-page documents, sequence of pages) are cor-
rectly converted into the document definitions for ABBY'Y FlexiCapture 10 with the same structure.

Custom document structure is not supported in ABBY'Y FlexiCapture 10. Templates with custom structure will be con-
verted into separate one-page Document Definitions.

If the structure of a batch (custom sequence of documents) was defined in ABBYY FormReader 6.5, it will be ignored,
and the batch will be considered as an arbitrary sequence of documents.

Compatibility with FormReader 6.5 validation rules
Support of ABBYY FormReader 6.5 validation rules in ABBYY FlexiCapture 10:

FormReader 6.5 Equivalent in ABBYY FlexiCapture 10 Convert?d
automatically

Check against a “Database Check” rule. No
database
Check sums “Check Sum” rule. No
Merge blocks “Merge Fields” rule. Yes
Search in the list of | Field properties, “Data Type” tab. List the variants of allowed values in the Yes
suggestions “Validation” field.

Field properties, “Data Type” tab. “AutoCorrect options” field. Yes
Replace Vglues Note. This rule will be converted if we find the value and write the result to the
from the list same field. If the fields are different, the rule cannot be converted, and the

“Script” rule should be used.

Field properties, “Data Type” tab. “AutoCorrect options” field. Yes
Replace characters Note. This rule will be converted if we find the value and write the result to the
from the list same field. If the fields are different, the rule cannot be converted, the “Script”

rule should be used.

. Field properties, “Data Type” tab. In the “Content” list, select “Date”; in the No
Normalize and « o 1 . . P
Content Details” dialog box, select the required formats; in the “Validation

check dates . )

field, enter the required constraints.
Reoular Field properties, “Data Type” tab. From the “Content” list, choose “Text” or Yes

gru ion select the “Process value as text” option for another content type. Enter the

expressions required regular expression in the “Validation” field.
Match blocks Can be implemented via a “Script” rule (see “Field match check” sample in No
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Help).
If-Then rules an be implemented via a “Script” rule (see Help for instructions on how to No
migrate).
Can be implemented via a “Script” rule (see Help for instructions on how to No
migrate).
Automation check | If the logic of the rule is too complex and requires an external component to be
used, the component should be called from within the code of a “Script” rule
(see “Automation rule” sample in Help).
VBScript rules Can be implemented via a “Script” rule. No
Sum m digits - sum “Sum in digits - sum in words” rule (for Russian language). No
in writing
Normalize prices
Pr.1ce m dlglFs . Not supported; can be implemented through an external COM component No
price in writing R
called from a “Script” rule.
Validate passport
series and number

The information about ABBYY FlexiCapture 10 rules can be found in the “Program Settings -> Document Definitions -> Rule

validation” article of the FlexiCapture Help File.

For more information on the “Script” rule, see the Appendix -> Using scripts in ABBYY FlexiCapture 10 -> Scripts for customiz-

ing processing -> Types of scripts -> Script rule article.

Template conversion issues and possible workarounds

The validation rules and batch or document structures used in ABBYY FormReader 6.5 have no analogs in ABBYY FlexiCapture
10 and should be re-created manually. The possible troubles with workarounds are described in the tables below.

Problem

Comment

Workaround

An error occurred during import:
Import failed.
Error: Unable to define fixed layout inside flexible.

This bug occurred when a
field was absent in an original
FlexiLayout, but the compiled
layout contained it.

Open the *.fsp project in
ABBYY FlexiLayout Studio 10
first to check that there are no
errors, and re-compile it.

Images do not match the converted fixed Document De-
finition, although the same images matched the template
before conversion.

This happens due to signifi-
cant changes in technologies.

Open the converted Document
Definition in ABBYY FlexiCap-
ture 10, delete anchors, separa-
tors and static text, and re-create
them automatically or manually.

Some rules which can be converted (see the table) are not
converted.

In ABBYY FormReader 6.5, it
was possible to create several
rules which changed the value
of the same field. This isn’t
possible in FlexiCapture 10.

Check if you really need such a
complicated structure. Maybe,
you can solve the problem using
the standard ABBY'Y FlexiCap-
ture 10 features. If not, use the
“Script” rule.

In ABBYY FormReader 6.5 EE, multi-page documents
were processed. After conversion, several one-page Doc-
ument Definitions were created instead of a multipage
Document Definition.

We cannot convert Custom
structure of documents be-
cause it isn’t supported in
ABBYY FlexiCapture 10. If
Custom structure was used in
FRO65EE, one-page templates
will be imported. See
Documents and batches struc-
ture.

The documents structure is
described in the
FRE6BatchDefinition.sql file.
If this file was damaged or
deleted, only one-page tem-
plates will be exported.

Some complicated structures
cannot be created in ABBYY
FlexiCapture 10.

Check if the
FRE6BatchDefinition.sql file
wasn’t damaged or deleted.

There were annexes in the documents. The annexes are
not enabled in ABBYY FlexiCapture 10 Document Defi-
nitions.

In ABBYY FormReader 6.5, it
was possible to add annexes
using custom structure. We
cannot import custom struc-
ture of documents. See
Documents and batches struc-

Enable annex pages manually in
the Document Definition
Properties dialog box, Assem-
bly tab.
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ture.

The rules are converted, new rules are created but the
order of rule execution differs from that in ABBYY For-

mReader 6.5.

In ABBYY FlexiCapture 10
the order of rule execution
doesn’t depend on the user’s
specification, it depends on the
document structure.

Try to re-create rules in such a
way that they won’t depend on
the execution order.

If the order is very important,
try to create a “Script” rule
which covers all your rules.

FlexiLayout couldn’t be compiled.

There are numerous changes
in ABBYY FlexiLayout Stu-
dio 10 compared to ABBYY
FlexiCapture Studio 1.5.

Open the *.fsp project in
ABBYY FlexiLayout Studio 10,
correct errors and re-compile it.

If there are errors, you will see
invalid elements with error de-
scriptions on the Errors tab.

Possible errors and workarounds

are described in the Errors in
converted FlexiLayouts section.

FlexiLayout has been compiled, but an error occurred

during matching of this FlexiLayout.

There are numerous changes
in ABBYY FlexiLayout Stu-
dio 10 compared to ABBYY
FlexiCapture Studio 1.5.

Open the *.fsp project in
ABBYY FlexiLayout Studio 10,
correct the code and re-compile
it.

Possible errors and workarounds
are described in the Errors in
converted FlexilLayouts section.

Errors which may occur while converting FlexiLayouts

Sometimes, the converted Flexible Description cannot be compiled, or there are errors during FlexiLayout matching.

If the Flexible Description cannot be compiled, you will see the corresponding message during templates conversion. Open the
* fsp project in FlexiLayout Studio 10. Some of the elements may be invalid and have error description on the Errors tab.

It is also possible that the FlexiLayout is successfully compiled, but some errors occur during matching.

If you have such problems after conversion, please check if it happened due to one of the errors described below.

Please note that some elements may be found in a different way now and the logic of Flexible Description may slightly change.
Test all FlexiLayout on the images before using them for recognition.

If you need assistance please contact our Technical Support.

Problem

| Comment

Workaround

A FlexiLayout will not be compiled with the following errors:

The name of an element coincides with a
function’s name that didn’t exist in pre-
vious versions.

Example: in version 1.5 (and 8.0) it was
possible to create a text element with a
name “RSA” and reference it using the
short name: RSA.IsNull. This code can-
not be compiled in ABBYY FlexiCapture
10.

If the element’s name coincides with a func-
tion’s name, it will be considered as a func-
tion’s name in the code. It’s possible to
create an element with the name PageNumb-
er, but it is prohibited to write PageNumb-
er.IsNull (the only possible way is to write
SearchElements.PageNumber.IsNull );

Use the full name of an element.

Example:
SearchElements.RSA.IsNull

If the element had a name which was
allowed in version 1.5 (or 8.0) but prohi-
bited in ABBYY FlexiCapture 10, and
there was a reference to this element
using a short name in the AdvancedCode,
this element will be re-named during
conversion, but the short name in the
AdvancedCode is not changed. So, in
advanced code, there will be a reference
to the element which doesn’t exist.

In AdvancedCode, the element
should be re-named manually.

The structure like this is now prohibited:

Let e = SearchElements.StaticText1;
e = SearchElements.StaticText2;

As the elements now have user-defined
properties, the elements of the same type are
not considered identical.

Change the mentioned structure as
follows:

Hypothesis e;

e = SearchElements.StaticText1;
¢ = SearchElements.StaticText2;

Incorrect usage of elements’ short names.
Example:
There are elements: SearchEle-

A conflict may arise when short names are
used. In version 1.5 (and 8.0), in case of
conflict, the high-level element was selected.

Use the full names of elements.
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ments.A.A, SearchElements.A.B, Sear-
chElements.A.C.

In previous versions, it was possible to
use the following structure in the code of
element C: A.B

In ABBYY FlexiCapture 10, such a
structure cannot be compiled. A is consi-
dered SearchElements.A.A, but this
element hasn’t a B field.

In ABBYY FlexiCapture 10, the low-level
element is selected.

The following errors may occur during layout matching:

Error at position -1: Text for search not
defined.

In 1.5, it was allowed to search a text which
consisted of a space only. In version 8.0 and
10, it isn’t allowed.

Use allowed text for searching.

Error in element "SearchEle-
ments.StaticText", Pre-search relations
section: D:\Tests\ForConversion\1.txt
was not found.

In ABBYY FlexiCapture 10, a reference
folder for relative paths to the text files used
in the StaticText element was changed. In
version 1.5 (and 8.0), the relative path began
from the batch’s folder (where the images
are stored). In ABBYY FlexiCapture 10,
they begin from the project’s folder (the
folder which contains the .fsp file).

Place the mentioned text file to the
folder indicated in the message (for
this example, you should put the file
“1.txt” to the following folder:
D:\Tests\ForConversion\). You can
also change the path to the file.
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Managing Your Licenses

After you install the program, you need to activate your serial number. This section describes the use of ABBYY FlexiCapture 10

License Manager, the license management utility supplied with ABBYY FlexiCapture 10.

Overview

ABBYY FlexiCapture 10 License Manager is a license management utility. It is installed on the Protection Server when the

server are installed.
The License Manager allows you to:

. add new licenses
. activate licenses
. view license parameters

«  select and enable licenses
Hardware licenses are activated in the same way as software licenses.

ABBYY FlexiCapture 10 License Manager

The main License Manager window contains the following columns:
. Licenses — displays the list of the installed licenses

. License parameters — displays the parameters of the selected license
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¥ ABBYY FlexiCapture 10.0 License Manager

License Service Help

Licenses

Serial Humber

Protection Type

W4 DVRP-1000-D000-4658-... Software (File)

Installation Type

Expiration Date
Until 13-07-12 14:00

Hide License Parameters <= ] l Activate License... l l Update License... ] l Select ] l Refresh ] I Close
License Parameters
Description .
Serial Number CWVRP-1000-0000-4658-2920-6103
Expiration Date Until 13-07-12 14:00
Protection Type Software (File) B
Virtual machines support Yes
License purpose
License purpose General
Business process outsourcing service (BP0 No
Workstations
Scanning stations 2
Verification stations
Project setup stations
o

License properties

. General — the serial number, expiration date, licensing method, ability to use a virtual machine

«  License purpose — type of license (software or hardware), ability to provide document processing services

. Work stations, Tools — restrictions on the number of stations in the system and the use of development tools (Flex-
iLayout Studio, FormDesigner).

«  Productivity — restrictions on the use of ABBYY FlexiCapture 10.

. Processing — additional document processing parameters: use of FlexiLayouts, use of additional recognition lan-

guages

«  Custom components — use of components created by users

. Import — additional import capabilities

. Export — additional document and image export capabilities

License statuses

. Activated (the license had been activated)

© 2011 ABBYY. All rights reserved.
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. Expired (the license had expired or the page limit has been reached)
The current (i.e. active) license has a v' next to it and is highlighted in bold.

Buttons

. Hide License Parameters<< (License Parameters>>) — hides (shows) the detailed information about the selected
license

. Activate License... - launches the ABBYY FlexiCapture Activation Wizard

«  Update License... - refreshes the information about the activated license

o Select - makes the selected license current (i.e. active)

«  Refresh —refreshes the information about the licenses available on the Protection Server

«  Close - closes the Licenses manager

Activating a license

ABBYY takes steps to protect its intellectual property from piracy. Software piracy is harmful both to manufacturers and to end
users alike. Unlike legally purchased software products, pirated software is never safe and secure.

If your end-user license agreement allows you to install and use the product only one computer, installing it on several computers
will breach the agreement and violate the copyright laws of the Russian Federation. The activation technology restricts the num-
ber of software copies that can be used simultaneously and thus prevents the installation of one licensed copy on an unlimited
number of computers. At the same time, one licensed copy may be installed and activated on one and the same computer any
number of times without any restrictions.

You will not be able to use the software product unless you activate it.

How activation is carried out?

The activation process takes very little time and is carried out via an activation wizard. The activation wizard helps you to send
the data required for activation to ABBYY. These activation data are sent to ABBYY in the form of a code (Product ID) which is
generated based on the hardware on which the product is installed. No personal data are used to generate the code and the user
remains completely anonymous.

The following activation methods are available:

. via Internet - activation is carried out automatically and takes several seconds to complete; this method requires
an active Internet connection

« by e-mail - an e-mail message is generated that contains the data required for activation; please do not alter the
body or the subject of the message to ensure a prompt reply from the mail robot
« by e-mail from another computer — an e-mail message is generated that contains the data required for activation;
you can use this method if the Protection Server is not connected to the Internet and e-mail messages cannot be sent
from it
. load activation file — connect an activation file you received by e-mail in response to an activation request
Once the activation is complete, ABBYY FlexiCapture 10 can be used on the server on which it was activated.

You can re-install ABBY'Y FlexiCapture 10 as many times as you need without additional activations (provided the Protection
Server is not re-installed).

Note:
1. ABBYY FlexiCapture stations automatically connect to the Protection Server and use the installed license.

2. If you re-install the Protection Server on a different computer, you will need to re-activate your licenses (in the case of a
license file) and change the address of the Protection Server in the Protection.ini file on the stations (see the “Connecting
stations to the Protection Server” section for details).

3. If there are no free activated licenses available on the Protection Server and a user tries to run the program on their
workstation, the program will not start and a warning message will be displayed.

4. Hardware licenses can only be activated over the Internet.

Connecting stations to the Protection Server

All the stations installed in the system access the Protection Server. The address of the Protection Server is stored in the Licen-
singSettings.xml file, which can be found in the installation folder.
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The address of the server is specified in the ServerAddress tag of the MainNetworkLicenseServer attribute.

To enable a station to access a new Protection Server, simply change the old name to the name of the computer where the Protec-
tion Server is installed.

The same applies to the standalone version of ABBYY FlexiCapture 10. If you have one license and several operator stations,
specify the address of the computer where the license is stored in the LicensingSettings.xml files on the workstations.

Remote stations get licenses from the Application Server. The Processing Server connected to the Application Server must be
running for you to get a license.
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Setting Up FlexiCapture 10 Distributed Installation

Setting up the system

Once the license is installed and activated, you should set up the system:
I.

Open the Administration and Monitoring Console. Create a database.
Note: If SQL Server is installed separately, use basic authentication.

To use a file storage folder, select the corresponding option and provide the path to the folder. This should be a local
folder on the Application Server.

Important! Under Windows Vista, Windows 2008 or later versions, a database must be created with UAC disabled. If
UAC is not disabled, a database can be created, but the Processing Server will not be able to connect to it.

Note: If no file storage folder is used, all project files are stored in the database. For small projects, in terms of efficien-
cy and security, the two approaches are equal. Storing the project files in the databases makes backing up and restoring
data easier but increases the size of the database, which may decrease the system performance. Therefore, storing
project files in the database should be selected only for demonstration projects.

Note: A file storage folder and a local file project must be excluded from the scope of anti-virus software and Window
indexing service used for quick search.

ABBYY FlexiCapture 10

Administration and Monitoring Console :
- English b
Monitoring Feports Service Permissions Downloads
Current settings
Server instance name: baikal-24sql2008r2
Database name: berezkina_10_1106({%ersion: 61)
File storage: C:%FileStorage
Apply patch | Connect to existing database | Create new database

2.

Server projects list

Refresh

Upload your project to the Application Server by starting the Project Setup Station and doing the following:

«  Create a new project (File=>New Project...). Create or import at least one document definition
(Project>Document Definitions).

. Open one of the samples (available at %allusersprofile’%\Application Data\ABBY Y \FlexiCapture\10.0\Samples, for
Microsoft Windows Vista and later - %public%\ABBY Y \FlexiCapture\10.0\Samples).

. Open a project you created in one of previous version of ABBYY FlexiCapture.

«  Open a new project and import a batch you created in FormReader 6.5 DE or EE.

For the correct operation, the project should contain at least one correct and connected document definition for
which export settings have been specified.

Next, upload the project to the Application Server (File=>Upload Project to Server...).

In the Administration and Monitoring Console, select Permissions=> Users.

Note: The user that created the database had the administrator rights and may start any stations and perform any types of
operations. You cannot divest the creator of the database of their administrator rights.
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4. To add a user, click the New user button. You can also import user information from Active directory. Click the Im-
port... button and find a user by name. Then use hyperlink in Login column to open page with user's information.

5. On the user page specify account information and roles. Administrator, Monitoring Operator and Processing Server roles
may access all projects. You must specify the projects accessible to user for the Project Settings Editor role. For the oth-
er roles you must also specify batch types.

ABBYY' FlexiCapture 10

Administration Monitoring Console

English v
Monitoring Reports Service Permissions Downloads
Last updated: 2/8/2012 7:07:56 PM  Refiesh

Users

Find New user Import...

Login Full name E-mail Groups Permissions [F]

Monitoring Operator ,
FIMEYIBeresking Processing Server ,
Administrator

Monitoring Operatar ,

FINE\BEREZKIMA-NEWE Processing Server , O
Administrator

Help Technical support www abbyy.com About ABBYY FlexiCapture 10

6. Ifrequired, create or import user groups and grant them the necessary access rights. Using groups saves time and makes
user management easier.
Note: The Administrator, Monitoring Operator, and Processing Server roles can be assigned without creating a project

in the database. The other roles require access rights to specific projects, therefore you need to create at least one project
before you can assign those roles.

Important! The account of the computer on which the Processing Server runs must be added to the list of users with the
Processing Server role. If this computer is part of a domain, the account will look like this: <Domain
Name>\<Computer Name>$ (e.g. Fine\quad-18). Subsequently, the Processing Server will automatically control the
Processing Stations, their access rights, etc.

7.  Start the Processing Server Monitor (Start>ABBYY FlexiCapture 10 Servers=>Processing Server) and set up the
server:
8.  Select Actions>Properties and specify the address of the Application Server (e.g. http://ApplicationServer).
__L

—

9.  Start the Processing Server by clicking ) .

=

10. Add Processing Stations by selecting Stations in the tree and clicking . Add the names of the stations or locate

them in the LAN:
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@I Processing Server Monit

File  Actions

Add Stations

Browsse for the stations you want to add.

9 & e

= @ ABBYY FlexiCapture || #

=@ SOKOLOV 1
[ Hot Folders
@ Stations
[ Tasks

Browse for Computer

Choose the computer you want to add:

=1 Start autc

----- Y 618

----- i} Aalekperov
----- i Abaskakov
----- i Abbyy-9qupizhéd
----- i Abbyy-cal
----- i Abramyan
..... § Act

----- i Afanasyev
----- i Afshost

----- i aAkhatov

----- § Al25-26

----- i Alekseev
----- W alekssevan

| ~

add

[0

s
| B

Close

< LIRS

Ready

Yes

Then select the stations in the list displayed in the main window of the Processing Server Monitor and click @ .

11. If Hot Folders are to be used for image import in any of the projects, connect these folders in the node of the same name:

e Processing Server Monitor - SOKOLOV
Fie Actions

a9 HF2 5 @

= @ soKoLov

= @ ABBYY FlexiCapture

@ sStations

For Project

Enable

Export List...
Select Al
2l [

Cirl+A

12. Ifrequired, specify the general project processing options on the Project Setup Station (“Default” batches,
Project>Project Properties..., Workflow tab). If several batch types are used, specify the processing parameters for
each batch type: select Project>Batch Types..., select the desired type, click Edit... and then click the Workflow tab.

Setting up Microsoft Internet Information Server (lIS)

Checking the operation of IS

To check the operation of TIS, start it by selecting Start->Control Panel> Administrative Tools=>Internet Information Ser-
vices. If a problem occurs when starting IIS, the following message will be displayed: “Unexpected error 0x8ffe2740 occurred”
for v. 5.1 (Windows XP) or “The process cannot access the file because it is being used by another process” for v. 6.0 (Windows
2003), v. 7.0 (Windows 2008) and v. 7.5 (Windows 2008 R2).

This error message means that port 80 is in use. To find out which application is using the port, do the following:

13. In the command line (Start->Run), type

netstat -anop TCP|find ":80"

© 2011 ABBYY. All rights reserved.
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The list of connections to port 80 will be displayed and the ID of the corresponding process in the following format:
TCP 0.0.0.0:80 0.0.0.0:0 LISTENING 1264

14. Type
tasklist /SVC /FI "PID eq 1264"

replacing 1264 with the ID of the process obtained at step 1. The result will be displayed in the following format:
Image Name PID Services

Virus.exe 1264 KillMePlz

15. End the process that uses the port.
Important! Do not switch IIS over to another port, as you will not be able to start the Application Server in this case.

Security settings

Major scenario
Conditions:

o All participants (computers and users) are in a domain.
Features:

. Requires minimum additional settings.
Actions:

1. After the system is installed, the administrator of the computer on which the Application Server is installed creates a da-
tabase and becomes the administrator of the system. The administrator may change the settings of the Application Serv-
er, upload projects to the Application Server, and grant access rights for projects.

2. The administrator may grant administrator rights to another user, thereby delegating the administration of the system to
that user.

3. The administrator grants the Processing Server rights to the computer on which the Processing Server is installed (in the
format <Domain Name>\ <Computer name>$ by default if the Processing Server operates as the Network Service; or a
specially created domain account that is assigned to the Processing Server). If required, the administrator may create and
set up special accounts for the Processing Stations.

4. The administrator uploads the projects and assigns roles to the operators.

Some of the stations are not in the domain
Conditions:

. Some of the stations (Scanning Stations, Verification Stations) operate remotely.
Features:

.  NTLM pass-through authentication is used. General principle: to enable user of computer M2 (account
M2/User[password]) to authorize on computer M1, you must duplicate this account (with the same password) on
computer M1, i.e. create M1/User[password].

«  The Processing Stations must be in the same domain as the Application Server.
Actions:

1. Do the steps of the major scenario above.

2. On the Application Server, create accounts corresponding to the remote users. On the remote stations, create identical
accounts (same names and passwords) and run the stations under these accounts.

Work group

Conditions:

The stations and the servers are in a work group.
Features:

. NTLM pass-through authentication is used. General principle: to enable user of computer M2 (account
M2/User[password]) to authorize on computer M1, you must duplicate this account (with the same password) on
computer M1, i.e. create M1/User[password].
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Actions:

. Basic authentication must be turned on in ISS to enable export from the Scanning Station by explicitly specifying
the user’s login and password.

Perform steps 1, 2 of the major scenario above.

On the computer on which the application Server is installed, create a local account for the server. In the IIS settings,
specify that the pool of FlexiCapture Web Services should run under this account.

Set up the Administration and Monitoring Console: in the IIS settings, go to the ASP.NET page and specify an account
for the FlexiCapture virtual folder (either the same account as in step 2 or a separate account).

If the database is located on a computer other than the Application Server, copy the accounts from steps 2 and 3 onto the
computer hosting the database. Additionally, duplicate the account of the administrator on the computer hosting the da-
tabase. The Administration and Monitoring Console will be run under this account in order to set up the Application
Server (to connect to the database).

Use the administrator account to run the Administration and Monitoring Console and create a new database.

On the computer on which the Processing Server is installed, create an account for it. Specify this account in the
Processing Server settings. Duplicate this account on the computer on which the Application Server is installed.

In the Administration and Monitoring Console, assign the Processing Server role to the Processing Server account
(created at step 6).

If the Processing Stations run on separate computers, create accounts for them and duplicate them on the Processing
Server.

On the computer on which the Application Server is installed, duplicate the accounts of all users that should have access
to the system and assign roles to the users in the Administration and Monitoring Console.

Oracle database settings

Prior to creating a database in Oracle, do the following actions:

1.

On the computer on which the Application Server is installed, install the Oracle client for Windows 32bit (even though
Windows x64 is installed) and Oracle DBMS for this OS. The Application Server does not work with the Oracle client
for Windows x64.

If Windows x64 is installed, pools for the Administration and Monitoring Console and the Application Server must
be set to 32-bit mode. For this, do the following:

- Execute the following command from the command line: cscript % system-

drive% \Inetpub\AdminScripts\adsutil.vbs set W3SVC/AppPools/Enable32BitAppOnWin64 true

This command switches the default pool to 32-bit mode, thus the default pool and the pools of the Administration and
Monitoring Console run in the same mode which is required for registration of ASP.net.

For this command to take effect, access to the Network Service account must be granted explicitly. To grand access to
the Network Service account, execute the following command: aspnet_regiis -ga "NT Authority\ Network Service".
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- Make sure that the World Wide Web Publishing service is running in 32-bit mode:
World Wide Web Publishing Properties (Lm:::f llil

General | Lag Dnl Recaven Dependenciexl

Service name: W 35N C

Display name: ublishin:

Provides 'Web connectivity and adminiztration ;l

Dezcrption: ] U .
= P thraugh the Intemet [nfarmation Services snap-n LI

Path to executable;

C:hAMD DWﬁ'xsystem32\hetsrv\inetinfu.e:-:e

Startup bype: I.ﬁ.utomatic j

Service status: Started

Sikart | Stop | Pauze Hesume |

Y'ou can specify the start parameters that apply when pou start the service
from here.

Start parameters: I

ak I Cancel Lpply

2. In Oracle DBMS create a user, e.g. FCUSER, and assign the CONNECT and DBA roles to this user. One FlexiCapture
database corresponds to one user. If several FlexiCapture databases running under Oracle DBMS are required, create a
user for each database.

3. Establish the connection between the client and the Oracle server using the Net Manager utility, which is installed to-
gether with the Oracle client (in the Administration configuration) and the database server. In the client utility, create a
new Service Naming element (a local naming method), which must be connected with the Oracle database server by its
SID. Test the connection with the database server on behalf of the user account created in step 2. Go to the next stop on-
ly if the connection test succeeds. If you cannot set up the connection, consult the Oracle documentation.

4.  When creating the database in the Administration and Monitoring Console, specify the name of the Service Naming
element created in step 3.

After you create the database using the Administration and Monitoring Console you should note that by default, an Oracle da-
tabase allows a maximum of 40 processes and 49 sessions. When these limits are reached, the following error message occurs:
“ORA-12516: TNS:listener could not find available handler with matching protocol stack”.

If required, increase the default values by using a script similar to the following:
connect sys/<Login> as sysdba;

alter system set sessions=<SessionCount> scope=spfile;
alter system set processes=<ProcessCount> scope=spfile;
shutdown immediate;

startup;

Recommendation for setting up FlexiCapture 10

General recommendation
To improve performance of ABBYY FlexiCapture, use the following recommendations:

- Install SQL Server and FlexiCapture Application Server on different computers. The Processing and Licensing servers can be
installed on the computer where the Application Server is installed.

- Do not install processing stations on the computes where FlexiCapture servers or SQL Server are installed.

- Do not store all data in SQL database. For these purposes, a File Storage should be used. This option must be selected when
creating a database in the Administration and Monitoring Console. If a file storage was not created when creating a database, it
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cannot be connected later while working. During work, it is also impossible to disconnect the file storage which was connected
when creating the database.

These recommendations are described in more detail below.
Configuring SQL Server
RAM

The amount of RAM available to SQL Server should be not less than the amount recommended by Microsoft for the given edition
of MS SQL Server (see the table of recommendations for different editions).

The more RAM is available, the larger part of database can fit in RAM which allows faster access to database.

However, if FlexiCapture servers are installed on the same computer, the amount of RAM available to SQL Server must be re-
stricted in SQL Server settings so that the amount of RAM was also sufficient for FlexiCapture servers including IIS (recom-
mended amount of RAM is at least 4 GB). Thus, in order to improve performance, it is recommended that SQL Server and Flex-
iCapture Servers should be installed on different computers.

Hard disk

It is desirable to place the database file on a fast hard drive (e.g., 15000 rpm/second). If SQL Server is installed on the same com-
puter with FlexiCapture Servers, it is desirable to use one hard disk for the %temp% folder of IIS and the File Storage and another
disk — for SQL database.

Database File

The process of increasing the database file may lead to a temporary decrease in SQL Server performance, so it is recommended to
specify in database properties in Autogrowth settings that a one-time increment of the database file must be at least 100 MB.

Recovery model
To improve performance of SQL Server, it is desirable to use a Simple Recovery Mode for the database.
Rebuilding indexes

After long work of FlexiCapture, a significant increase in the size of database can be noticed. At the same time, more than 50% of
the space can be occupied not with data, but with the indexes in tables. In order to decrease the size of database and improve per-
formance, it is recommended that indexes of the Batch, Document, Page, EventLog and other tables should be rebuilt periodically
(e.g., once for every million pages processed).

Estimating the size of File Storage

Most of the space in file storage is occupied by images being processed in the system. For each loaded file, its source image is
stored as the original; besides black-and-white image copies and image thumbnails are created. For color images, color copies
with quality loss are also created.

The level of quality loss is specified in batch type properties, in the Displayed image quality field.
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http://msdn.microsoft.com/en-us/library/ms143506.aspx#Web64

Batch Type Properties @Iﬁ

| Expart | Warkflow | MNet References
General | Image Preprocessing Recognition | Event Handlers I Verification
= E
Mame: == fDE f= b
Description:
| |

Default batch priority: [Normal v]
Digplayed images quality: [EU% v]
Reqgistration Parameters

Mame Required Add...

oK ] [ Cancel ] [ Apply ] [ Help

L

To get a relatively accurate estimate of the file storage size, you can upload 10 typical images to FlexiCapture and view the size of
a file storage folder, in which the batch (<FileStorage>\<GUID>\project <id>\0000-0999\<Batch Id>) is stored.

Estimates for the file storage obtained during testing are as follows: for 1 image, 3-6 times more space in the file storage than the
image size is needed.

File Storage

For the file storage, it is recommended to use a disk that is local relative to the Application Server (or a system of comparable
performance). To achieve maximum performance, the %temp% for IIS must be located on the physical disk. If IIS runs under the
Network Service account, a path to folder %temp% can be specified in the registry (registry branch [HKEY USERS\S-1-5-
20\Environment], variables < TEMP» and «TMP»).

In order to increase performance, it is recommended that a file storage folder should be excluded from the scope of anti-virus
software, Window indexing service and other processes that require long-term access to the disk.

Preferably use a faster hard drive (e.g., 15 000 rpm/secondy).

Application Server

Caching

In order to decrease the amount of memory occupied by IIS, it is necessary to disable Output in the IIS settings. Using the cache
does not lead to increasing performance, as the identical information is not frequently requested by FlexiCapture.

Configuring settings of the Application Server Recycling Pool

For FlexiCapture 10 Web Services, the Application Server pool, it is necessary to specify Recycling settings, that is to enable
cleanup of the pool when it reaches a certain threshold of consumed memory. The threshold is determined based on the amount of
available memory in the system: when IIS consumes maximum memory, there must remain enough memory for normal function-
ing of the operating system and other applications that can be installed on the same computer.

It is recommended to set up a forced cleanup of the Application Server pool when the amount of occupied memory reaches
1200000 KB.

© 2011 ABBYY. All rights reserved. 63



Edit Application Pool Recycling Settings

-

Recycling Conditions

NE

—Fixed Intervals

™ Regular time intervals {in minutes): ™ Fixed number of requests:

I l—

™ Specific time(sk

Example: 8:00 PM, 12:00 AM

—Memory Based Maximums
I ‘irkual memory usage (in KBJ: ¥ Private memory usage (in KBJ:

| |1200000|

Brevious | Mext I Einish I Cancel |

Number of threads

For the Application Server pool, the number of working processes can be specified. The optimal number of threads is two threads

per processor core if hyper-threading technology is not used on the computer and one thread per virtual core if hyper-threading is
used.

™E Internet Information Services (IIS) Manager

IS[=1E3
@ S [ L} ¥ FORMSTEST » Application Fools | & e -
File  Wew Hslp
&,v E t | 3‘_ | #. qg! App"catlon Pools .; Add Application Poal, .
E| :; i?;;ii; {FINEY azyUzin) This page lets you view and manage the lisk of application pools on the server. Application poals are associated with worker processes, conkain one or more E‘W
3 Anplication Poos applications, and provide isolation among different applications, application Pool Tasks
@ Sites Filker: - Go - %Shuw All |Group byt Mo Grouping - P Start
Mame = | Status I MET Frame. .. | Managed Fipeli. .. | Identit: | Applications @ stop
.;’ASP.NET v4.0 Started v4.0 Inteqgrated ApplicationPocliden.., 0 & Recyde..
.;;:ASP.NET v4.0 Classic Started v4.0 Classic ApplicatiorPocliden,,, 0 Edit Application P‘m} ”””” e
L2} Classic MET AppPocl Started  v2.0 Classic applicationPooliden... 0
=} DefaultappPanl Started  v2.0 Integrated applicationPooliden... 3 (=] Basic settings...
[ FlexiCapture 10 Monitoring Started  v2.0 Integrated MetworkService 1 Recycling...
[E¥FlexiCapture 10 Web Services Started Mo Manage... Classic NetworkService 1 Advanced Settings. ..
dvanced Settings HE il
K Remove
E {General) =
\MET Framework Version No Managed Code View Applications
Enable 32-Bit Applications True @. Help
Managed Pipeline Mode Classic Onine Help
FlexiCapture 10 Web Services
Queue Length 4000
Start Automatically True
E crPu
Lirnit 0
Limit Action MoAction
Limit Interval (minutes) ]
Processor Affinity Enabled False e
Processor Affinity Mask 4294967295
E Process Model
Identity NetworkService
Idle Time-out {minutes) 20
Loadlleer peckil Ealse
Maximum Warker Processes 3 I
IMG TP
Fing Maximum Response Time (seconc 90
Ping Period (seconds) 30
Shutdown Time Limit {seconds) a0
Fartun Tire Lirt fscands) an =
Name
corterty, | (mame] The application pool name s the unique identifier For the application pool.
Ready L=

Ok Cancel
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Configuring FlexiCapture input and output
Frequently, the bottleneck that limits performance of the system is the input (import) or the output (export).

Below are the two ways to increase performance in bottlenecks of FlexiCapture:

1. Ifitis assumed that a large number of Processing Stations will simultaneously import files from a hot folder or export
files to file system, then the hot folder and/or the export target must be located on the computer with the server edition
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of the operating system. Normally, client operating systems support a limited number of connections which may lead to
error in import/export tasks.

If a hot folder is assumed to be processed at several Processing Stations, then bandwidth to the hot folder will be divided
between the Processing Stations which may lead to bandwidth shortage. In this case, it is recommended to use multiple
independent hot folders. If export to files is performed, it is recommended that export target should not be on the same

computer with the hot folders
Using performance counters
To monitor FlexiCapture state and search for bottlenecks, the Performance Monitor utility can be used.
FlexiCapture counters

FlexiCapture own counters are located in the category FlexiCapture.

@Performance Monitor !E I

'@S\) Fil=  Action Wew MWindow Help

JET
e %mEm|E

() Performance I 2 - % 21 F1E @1 M E

=] L gw Maonitoring Tools Add Counters

B8 Performance M
4 Data Callector Sets

) - Available counters
[ Reports

—Added counters

Select counters from computer:

Counker | Parenk | Inst... | Computer |
I <Local computer = j Browse... |
Distributed Transaction Coordinator &3] ;I
Event Tracing for Windows ey
Event Tracing for Windows Session
FlexiCapture =

counk
ASCT latency
Cores Count

Instances of selected object:

<Al instances

Processing Server

j Search |

Add == | Remave <=
L il 74835 PM
™ Show description Help | oK I cancel |
tian | 1:40
Shiow Color Sicale Cauriter Inskance Parent: Object Camputer

v
1]

Values of the counters are recorded by the Processing Server, so the counters are available in the computer where this server is
installed.

As the Processing Server is a 32-bit application, the Performance Monitor utility must be run in 32-bit mode when used in 64-bit
computers. For this, enter the following command in the command line (cmd.exe):

mmec /32 perfmon.msc

By default, recording counters by the Processing Server is disabled. To enable counters recording, perform the following actions:

1. Start the Processing Server console. For this, on the computer where the service of the Processing Server is started, ex-
ecute the following command in the command line (cmd.exe):
FlexiBRSvc.exe please obey
2. Set the value of the server parameter PerformanceCounting to true. For this, execute the command:
set PerformanceCounting=true
3. Check the state of the PerformanceCounting parameter with the “view” command.
4.

Quit the Processing Server Manager console using the “quit” command.

Note: To view help on the Processing Server Manager console, use the “help” command.
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[+ Administrator: indows" system32 cmd.exe

C:sUserssazyuzin»""C:sProgram Files (x86)>~ABBYY FlexiCapture 10 ServerssFlexiBRSv
c.exe' please ohey

>zet PerformanceCounting=true
Juiew

——Server FORMSTEST

State: Stopped

Total cores: 0

Free coresz: 0

Server lag time: OO:OM
———HotFolders:

PMuHaHcw:= Dizabled

———Parameteprs:

Mame=FORMSTEST
ApplicationServer=http: »FORMSTEST
RestartPeriod=0

PerformanceCount ing=true
riteLog=true

C:vlzsershazyuzin

Description of counters:

1. ASCT Count — Application Server Communication Threads count. The number of running threads used for interaction
with the Application Server. By default, takes values from 1 to 3. Each thread opens its session. Additional threads are
started if, for the existing threads, latency (ASCT Latency) has reached two seconds.

2. ASCT Latency — Application Server Communication Thread latency (ms). The latency of processing requests in the
flows of interaction with the Processing. The downtime of queuing requests measured in milliseconds.

The smaller this value, the better. The ideal value is zero. Values within 1000 (1 second) are the norm.

When the counter value reaches 2 seconds and the maximum number of threads is not running one more thread is
started. When the value reaches 30000 (30 seconds), the Processing Server switches to a critical mode: it stops taking
new tasks and retrieving information about projects on the server until the queue is unloaded. Therefore, a long stay is
the state > 30 seconds is generally undesirable.

3. Primary Thread Latency — a delay in the response of the Processing Server measured in milliseconds. This index
shows the responsiveness of the server. The increase of this index leads to “freezing” of the Processing Server Monitor.

It is desirable that the value of this counter be minimal. This counter is the most critical. The server does not have auto-
adjusting by the value of this counter. A response delay of more the 10 seconds is highly undesirable. As a rule, an ex-
cessive growth of this counter means that a network interaction with some station is extremely slow.

Note: With the “view” command of the Processing Server console, you can output the “Server lag time” value that cor-
responds to the maximum of the Primary Thread Latency and ASCT Latency values.

4. Task Queue Size the size of the buffer allocated for the task. Includes all tasks displayed in the Processing Server Mon-
itor as well as some of the tasks deleted over the past 5 minutes. This counter does not matter much in terms of adminis-
tration however it can be used to monitor the correlation between the number of tasks in the Processing Server and the
occupied memory.

5. Cores Count — the number of cores in all started (which are in s state Started) Processing Stations of FlexiCapture.

6. Free Cores — the number of free cores in all started (which are in s state Started) Processing Stations of FlexiCapture.
Allows you to estimate, whether there are enough cores in FlexiCapture.

7. Pending Tasks —the number of tasks taken into processing by the Processing Server, but not yet assigned to a
Processing Station. Such tasks are displayed in the Processing Server Monitor in a Pending state. Note that this number
is not the number of tasks queued in the Processing Server.

This number may be proportional to the total number of cores in the system, but it should not be increased indefinitely.
Admissible value: up to 2 tasks per 1 core.
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10.

11.

Running Tasks — the total number of tasks being executed in the Processing Server at the moment.

Export Count, Import Count, Recognition Count, Other Tasks Count — the number of corresponding tasks (export,
import, recognition and others) over the past 5 minutes.

Export Time, Import Time, Recognition Time, Other Tasks Time — an average execution time for the corresponding
tasks (export, import, recognition and others) over the past 5 minutes.

Modification Server Locks Count — the number of documents that are blocked for executors. The counter applies for
the Processing Station only.

System counters

Sometimes, insufficient performance can be caused by the used hardware. In order to determine whether the hardware complies
with the load and whether it has bottlenecks, system performance counters must be used. Counter used for different system com-
ponents are described below.

RAM
1.

Memory: Available Mbytes — the amount of physical memory (RAM), in bytes, available to processes running on the
computer. RAM consists of the physical memory and a swap file. If the RAM in the system is not enough, the paging
mechanism is used which can lead to slowdown.

Paging File: Usage — the use of paging. Data and code in the memory are divided into pages. On Intel, one page is
equal to 4096 byte. Paging is the process of moving pages between the physical to virtual memory. Excessive move-
ment of pages from disk into memory and vice versa can lead to severe CPU load. Such a situation may look like a
problem with the processor or disk.

Memory: Committed Bytes — the committed memory. The memory reserved in the file pagefile.sys in case you need to
dump the contents of physical memory to disk. The amount of allocated memory of the process characterized the
amount of memory actually consumed by it. The amount of allocated memory is limited to the size of the paging file.
The limit of the amount of allocated memory in the system (Memory: Commit Limit) is determined by how much
memory can be allocated to processes without increasing the size of the paging file. The counter shows the total amount
of allocated memory for all processes that is the actual amount of memory used by the system.

Memory: Page Faults/sec shows how often the data are outside the working set. The working set is the physical memo-
ry (RAM) visible to a process or a program. Page faults occur when the program requests a code or data page which is
not in the working set and must be found elsewhere. Includes soft page faults and hard page faults. A soft page fault is a
situation when the program requests a page which is memory but out of working set. In this case, restoring data from
disk is not required. A hard page fault is a situation when the program requests a page which is not in the physical
memory (RAM) and must be restored from disk. Faults of this type are the best to show the presence of bottlenecks in
the memory configuration. More than 5 faults per second show that RAM should be increased.

Memory: Page Input/sec total number of pages read from disk to resolve hard page faults. Comparing with Page Faults/sec
shows the number of soft page faults.

Memory: Pages/sec — total number of pages read from disk and written to disk. This is the sum of Page Outputs/sec
(the number of pages that had to be written to the disk to make room in RAM for other pages as a result of page fault)
and Page Inputs/sec. The admissible average value is 0 — 20. The Pages/sec value of more than 5 per second indicates a
bottleneck in memory configuration. Comparing with Page Faults/sec gives an idea about the number of soft page faults
and hard page faults.

It is also recommended to monitor the memory occupied by the following processes:

e  FlexiBrSvc.exe — the process of the Processing Server and the Processing Station. If both services are installed on
the computer (not recommended), they can be distinguished by PID specified for the corresponding services.

e w3wp.exe — IIS working processes.

e  sqlserv.exe — SQL Server process

Processor

It is recommended to exclude memory and other bottlenecks that load the processor before diagnosing a bottleneck caused by
a process.

Identify processes that occupy more than 80% of CPU time. If the length of the queue is more than 2 threads, the bottleneck
in operation of the system is probably caused by this process.

l.

System: % Processor Time: _Total — time (in percentage of the whole working time) during which all processors were
busy. For one processor, it is equal to the counter Processor: % Processor Time. For multiple processors, an average
counter value is used. The counter measures how much time (in %) the system spends processing Idle processes and
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subtracts this percentage from 100 %. The resulting value corresponds to the percentage of time, the processor actually
spent working on productive threads.

Processor: % Total Processor Time: - the same as System: % Processor Time, though measured for each processor.

System: Processor Queue Length shows how many threads are ready in the processor queue, but not currently able to
use the processor. Does not include a thread that is processed at the moment. Shows the current (not an average) value.
The counter value of more than 2 indicates a bottleneck.

Disk

1.
2.

LogicalDisk or PhysicalDisk: % Disk Time — indicates how busy the disk is (% of working time).

LogicalDisk or PhysicalDisk: Current Disk Queue Length — measures the number of the I/O transactions that are
waiting to be handled. Contains the current value (not an average). The counter value of more than 2 for a long period of
time indicates a bottleneck.

Disk Bytes / sec: - the number of bytes transferred to the disk per second. The primary measure of the disk
performance.

Avg Disk Bytes / Transfer: - the average number of bytes transferred per read of the disk system. This is an indicator
of the disk efficiency. The higher the value, the better.

Network interface

1. Network Interface: Current Bandwidth — bandwidth of the network interface.

2. Network Interface: Bytes Total/sec — load of the network interface. If the load of the network interface is 75% or more
of the bandwidth, than the network interface is a bottleneck. It is also worth comparing the load with the base mode in
which the work was stable.

3. Network Interface: Output Queue Length — network interface. If an average value of the counter is more than two, it
means that the network interface (or the capacity of the network infrastructure) cannot cope with transferring data pro-
vided by the server. That is, server provides data at a faster rate than the network interface is able to pass.

IS

1. W3SVC_W3WP: Active Threads Count: FlexiCapture 10 Web Services — the number of active threads in IIS.

2. WebService: Current ISAPI Extension requests: Default Web site (if the FlexiCapture Application Server has not
been transmitted to a different site by the user) — the queue of requests to be processed in IIS. If the queue is significant-
ly (2-3 times) larger than the number of active threads in IIS, then IIS is likely to be a bottleneck. You should take into
account that the bottleneck may also be the SQL Server that executes requests for a long time causing the queue of re-
quests to increase.

SQL Server

SQL Server has a large number of performance counters which can help you not only estimate the server load, but also, for
example, investigate the behavior in case of custom settings (non-optimal settings can increase the load on the server which
can be visible with the help of the counters).

We recommend using the main counter responsible for the server performance:

L.

SQLServer: SQL Statistics: Batch Requests/Sec counter — this counter measures the number of batch requests re-
ceived by SQL Server per second and allows you to monitor the load of processors in the server. In general, more than
1000 batch requests per second tells of a very high load on the SQL Server and may mean that if you have not expe-
rienced a shortage of CPU resources, you may run into it in the near future. Of course, this number is relative, and the
more powerful hardware you have, the more batch requests per second can be handled by SQL Server.

In terms of network bottlenecks, a typical network card with a capacity of 100 Mb/s can only handle about 3000 batch
requests per second. Under similar loads, you may need to switch to a network card with capacity of 1 Gb/s.

You can also use the counter SQLServer: Databases: Transaction/Sec: _Total to measure the total activity of SQL
Server. However, it measures only the activity within the transaction, not the whole activity, which can lead to errone-
ous results.

You can also use the following counters to analyze the amount of memory consumed by the server and estimate whether the serv-
er has enough memory:

2.

SQLServer: Memory Manager — Target Server Memory (KB) shows how much memory is required for SQL
Server. If the value of this parameter matches the value of SQLServer: Memory Manager — Total Server Memory
(KB), it means that SQL Server has enough memory.

SQLServer: Memory Manager — Total Server Memory (KB) shows how much memory SQL Server actually uses.
If the value of this parameter matches the value of SQLServer: Memory Manager — Target Server Memory (KB),
it means that SQL Server has enough memory. However, if the value of this counter is smaller, it means that more
available memory is needed to optimize performance of SQL Server.
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Logging

Administration and Monitoring Console logs

The event and error logs available in the Administration and Monitoring Console are the main logs that register errors that occur
in the system in general. These logs record all errors that occur during document processing and affecting the processing and all
events that occur during document processing. To view the logs, select Monitoring—=>Event Log and Monitoring—> Error Log in
the Administration and Monitoring Console. In the settings of the Administration and Monitoring Console, you can specify what
type of events should be logged. Logging all events is not recommended, as it can lead to a significant increase in the size of the
database during an intensive processing.

Task processing logs on the Processing Servers

The Processing Server logs the processing of the tasks. The list of the active tasks and their logs can be accessed via the
Processing Server Monitor. To view a task log, select Actions=> View Log... when selecting the task.

OS event logs on the servers

The server components (Application Server, Processing Server, and Processing Stations) log errors and warnings in the local
event log of the operating system under which they are running (section: Application, sources: FlexiCapture Web Services and
FlexiCapture Processing Server). These logs can be accessed by the administrators both locally and remotely via the standard
Event Viewer tool of the MMC console.

The local OS event log records not only processing errors, but also all errors in the operation of the server components not directly
related to the processing of documents. This log will list processing errors even if the Application Server is inaccessible at the
time of error and the error cannot be logged in the ABBYY FlexiCapture log.
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Working with Clusters

ABBYY FlexiCapture 10 supports clusters.
There are two important benefits to using clusters:
e  Fault tolerance: in case of failure of one of the servers, the request will be executed by another server.

e  Distributed workloads: query processing is distributed among cluster nodes. This improves performance and increases
fault tolerance.

The following ABBYY FlexiCapture 10 components can be installed on clusters:

e  Processing Server

e  Licensing Server

e  Application Server
ABBYY FlexiCapture can work with Microsoft SQL Server installed on failover cluster.
The Processing Server and the Licensing Server are installed on failover clusters.

The Application Server, the Administration and Monitoring Console, and the Web Data Verification Station, which use IIS (Inter-
net Information Services), are installed on NLB (Network Load Balancing) clusters.

Note. Failover and Network Load Balancing clusters cannot work on the same computer.
The following figure displays the clusterization of ABBY'Y FlexiCapture Servers and Microsoft SQL Server:

Processing and Protection

Application Server (NLB cluster) Servers {FailOver cluster)
~ ~ hY ~
NS NS NS NS
Q Q Q Q
NS NS NS NS

ay
(a

SQL Server (FailOver cluster)

The deployment of the Processing Server and the License Server on clusters is described below in this guide.

Setting Up the Processing Server

Failover clusters are used for clustering the Processing Server.
A detailed guide to failover clustering can be found on the Microsoft website.

Deploying the Processing Server on a Failover Cluster
In this section, you will find step-by-step instructions for setting up the server on a failover cluster.

Note. The addresses, computer names, domain names, etc. used below are not mandatory and may be changed by the administra-
tor.

Note. The following server configuration is intended only for local use in a local area network.
Important! The names of servers, services, and shared folders must not contain spaces.
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Basic Configuration of the Failover Cluster

In this example, the processing server is deployed on a FOC cluster (FOC.cluster2008r2.ru). The cluster uses a network with the
address 192.168.0.0/24 and the domain cluster2008r2.ru.

The cluster consists of two nodes: Nodel and Node2.
Addressing in the Cluster

The Nodel and Node2 nodes have two network interfaces: one interface belongs to the 192.168.0.0/24 network, the other may
belong to your local area network (for example 10.0.0.0/16). The data storage only interfaces with the 192.168.0.0/24 network and
is available only to the cluster nodes (i.e. Nodel and Node2).

Both networks are available to the cluster FOC.cluster2008r2.ru. Cluster traffic should only be allowed in the designated network
192.168.0.0/24 for security and workload balancing reasons. External users can access the data storage through requests to Nodel
and Node2. In order to allow cluster traffic in the 192.168.0.0/24 network, open the Failover Cluster Manager, select Cluster
Network in the Networks group, and choose Enabled in the Cluster Use column (see the screenshot below).

& Failover Cluster Manager =10/ x|
File Action \View Help
&= | 5=l
o~ =
B s ke

Bl (5 Nodes View »
= Nodel Name | Status | Cluster Use
% Node2 1 Cluster Network () Up Enabled |G Refresh
) Storage 53 Extemal Network {#) Up Disabled Help
E j;:l Metworks
ﬁj;:i?:litl:emork Show the critical events f...
= B Properties
Help
ii] Cluster Network
Status: Subnets:
Up 152.168.0.0/24 (IPw4)
a | ol
| |
Interfaces and networks:
Interface Network Description
Storage 192.168.0.1/24 Centralized storage
Nodel 192.168.0.11/24 Cluster node
Node2 192.168.0.12/24 Cluster node
FOC 192.168.0.10/24 Cluster address
FC10ProcServer 192.168.0.2/24 Address of the service running in the cluster

Domain users
To set up domain user accounts:
1. Create two domain users, for example cluster2008r2\nodeladmin and cluster2008r2\node2admin.
2. Give administrator rights to cluster2008r2\nodeladmin on Nodel and to cluster2008r2\node2admin on Node2.
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Important! These user accounts will only be used for working with ABBYY FlexiCapture in a failover cluster to ensure correct
usage of shared network resources.

Important! Clustering requires the use of domain accounts. It is not possible to work under a local user account.
Adding the ABBYY FlexiCapture 10.0 Service to the Cluster

Install ABBYY FlexiCapture on Nodel and Node2, then create a network folder for the FlexiCapture service.
Creating the Service

Complete the following steps to create the service:

1. Right-click the Services and Applications group and choose Configure a Service or Application...

ﬁ Failover Cluster Manager - |EI|5|
File Action \View Help
&= |z
°
B scrvices and cogicaiions) jons  Recent Cluster Events: Noneinthe asf =c Vo> 2ne 2PPlcati-
L= Nodes '3:':“"1"9”'": a ||'--="ﬂ'-'”--- aﬂ Configure & Service ...
~| Storage |5 | Type | Cumert Owner | Auto st=
e Virtual Machines... 3 Virtual Machines... »
L53 Networks
Cluster Events Mare Actions... 3 More Actions... »
View 3 View »
Refresh no services and applications in the cluster. [G] Refresh
Help ﬂ Help
Status: Auto Start: Prefermed Owners:
Aerts: Storage: Curmrent Owner:
Client Access Name: Capacity: Other Resources:
IP Addresses:
Kl | i

|This action enables you to select a service or application that you can configure for high availability. |

2. Select Generic Service from the list of services and click Next.
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5 High Availability Wizard

"= Select Service or lication
& fep

Before You Begin

Select Service
Client Access Point
Select Storage

Replicate Registry
Settings

Corfirmation

Configure High
Auailability

Summary

Select the service or application that you want to configure for high availability:

5" "File Server
E__g] Generic Application
\i=2) Generic Script

® . Generc Service

& Message Queuing
ﬁ@ther Server
= Print Server

‘M Remote Desktop Connection Broker
= Akiebsiml Manbnimn

;- Intemet Storage Name Service (iSMNS) Server

;I Description:

You can configure high availability for
some senvices that were not onginally
designed to run on a cluster. For more
informaticn, see Configuring Generic

Applications and Generic Services for

high availability.

Maore about services and applications you can configure for high availability

< Previous I Mext = Cancel I

3. Choose ABBYY FlexiCapture 10.0 Processing Server from the list of available services and click Next.

5 High Availability Wizard

"= Select Service
@

Before You Begin

Select Service or
Application

Client Access Point
Select Storage

Replicate Fegistry
Settings

Corfirmation

Configure High
Auailability

Summary

Select the service you want to use from the list:

Name

| Description -

ABBY™ FlexiCapture 10.0 Licensing Service

ABBY™ FlexiCapture Licensing Service —

ABBYY FexiCapture 10.0 P
Application Exqperence
Application Host Helper Service
Application |dertity

Application Information
Application Layer Gateway Service
Application Management

ASP NET State Service

Backaround Inteligent Transfer Service

sing Server

ABBYY RexiCapture Pr
Processes application compatibility cache reque...
Provides administrative services for |15, for exam. ..
Detemines and verfies the identity of an applica...
Faciltates the nunning of interactive applications...

sing Server service

Provides support for 3rd party protocol plug-ns f...
Processes installation, removal, and enumeratio ..
Provides support for out-of-process session state...
Transfers files in the backaground using idle netw... LI

< Previous I Mext = Cancel

4.  Enter the name of the service (FC10ProcServer in this example) to be used by clients and choose an address
(192.168.0.2 in this example). Click Next.
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5 High Availability Wizard

ﬁ Client Access Point

L

Before You Begin
Select Service or
Application
Select Service

Client Access Point

Select Storage

Replicate Registry
Settings

Corfirmation

Configure High
Auvailability

Summary

Type the name that clients will use when accessing this service or application:

Blemme |FC10ProcServer

One or more |Pv4 addresses could not be configured automatically. For each network to be used, make sure

the network is selected, and then type an address.

| Networks Address

i 192.168.0.0/24 152

%8 . 0

Maore about how clients access & clustered service or application

< Previous I

Neod >

Cancel

5. Choose the shared drive you created for centralized storage and click Next.

5 High Availability Wizard

tﬁ Select Storage

Tl

Before You Begin
Select Service or
Application

Select Service
Client Access Point

Select Storage

Replicate Registry
Settings

Corfirmation

Configure High
Auvailabiliy

Summary

Select onby the storage volumes that you want to assign to this service or application.

You can assign additional storage to this service or application after you complete this wizard .

Mame | Status

i FlexiCaptureStorage @ Online

< Previous I

Neod >

Cancel

6.  Specify the registry key:
e HKEY LOCAL MACHINE\SOFTWARE\ABBYY\FlexiCapture\10.0 — for x32 systems
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e HKEY LOCAL MACHINE\SOFTWARE\Wow6432Node\ABBY Y \FlexiCapture\10.0 — for x64 systems (see the
screenshot below)

B High Availability Wizard X

|°— Replicate Registry Settin
;Jj p egistry gs

Before “fou Begin Programs or services may store data in the registry. Thersfore, t is impaortant to have this data available on
) the node on which they are running. Specify the registry keys under HKEY _LOCAL_MACHINE that should

Sele;:t Semce = be replicated to all nodes in the cluster.

Application

Select Service

Cliert Access Poirt

Select Storage

SOFTWARE \WowbB432Node \ABBY ™ FlexiCapture®\10.0

-ate Registny

ings

Corfirmation

Configure High
Auailability
Add... Modify... Bemove

Summary

< Previous I Mext > Cancel I

7.  Click Next to confirm the settings.

B High Availability Wizard X

—=== Confirmation
@

Before You Begin You are ready to configure high availability for a Generic Service.

Select Service or

Application

Select Service Service: ABBYY FlexiCapture 10.0 Frocessing Server ﬂ
; . ' (ABBYY.ProcServer.FlexiCapture.10.0)

Cliertt Access Poirt Storage: FlexiCaptureStorage

Select Storage Network Name: FC10ProcServer

Replicate Registry IP Address: 192.168.0.2

Settings Registry Key: SOFTWARE\WowG432Node WABBYY \FlexiCapture\10.0

= Filez (x286)\ABBYY FlexiCapture 10.0

— - Parameters: Servers\FlexiBRSvc.exe \service -stationType:server -

Configure High inifile:\\fcl0proczerver\ClusterTemp\Serversettings.xml

Auailability

Summary ﬂ

To continue, click Mext.

< Previous I MNext = Cancel

8. To complete the creation of the service in the cluster, click Finish.
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5 High Availability Wizard x|

- o S
@ ummary

Before You Beain High availability was successfully configured for the service or application.
Select Service or
Application
Select Service ﬂ
Cliert Access Point s I ABBYY FlexiCapture 10.0 Processing Server
T ervice: (ABBYY.ProcServer.FlexiCapture.10.0)

Select Storage Storage: FlexiCaptureStorage
Replicate Registry MNetwork Name: FC10ProcServer
Settings IP Address: 192.168.0.2

S Registry Key: SOFTWARE\Wow6g432Node\ABBYY"\FlexiCapture\10.0
Corfirmation
Corfi Hid Files (x86)\ABBYY FlexiCapture 10.0
o 'Ilgll;'ll?- Ign Parameters: Servers\FlexiBRSvc.exe \service -stationType:server -
SITERL inifile:\\fclOprocserver\ClusterTemph\ServerSettings.xml 7|

Summary -

To view the report created by the wizard, click View Report.
To close this wizard, click Finish. Yiew Rsport...

Creating a Shared Folder for the Processing Server Service

1. The cluster nodes Node 1 and Node 2 need a shared folder where to store their temporary files. To create a shared folder

for the nodes, right-click the service you created (in this case FC10ProcServer) and choose Add a Shared Folder. In
this example, the shared drive H:\ was used (this drive was earlier created at the Storage computer). In the Location
field, enter the name of the folder you want to share, for example H:\Cluster Temp.
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% Provision a Shared Folder Wizard (FC10ProcServer) _1Oo] =|

Bl

Steps:

Shared Folder Location

Specify the folder that you want to share. On a volume with appropriate characteristics
Shared Folder Location and space, select an existing folder or create a new one. f an appropriate volume does
not exist, click Provision Storage and create one.
MTFS Permissions
Share Protocols

Location:
Review Settings and Create

Share HAClusterTemp Browse... |

Confimation
Awvailable volumes:
Volume | Capacity | Free Space | Type
Mew Volume (H:) 1,021 MB 588 MB Simple
4] | B
— Details
Wolume: Mew Volume (H:)
Shadow copies:  Unknown
Indexing:  Unknown
Highty available server: FC10PROCSERVER
Provision Storage ... |
< Prewious | Neod > Cancel
2.

To edit access permissions, select the Yes, change NTFS permissions option and click the Edit Permissions... button.
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% Provision a Shared Folder Wizard (FC10ProcServer)

_ o x|
~ | NTFS Permissions
-
Steps:
Specify NTFS pemissions to control how individual users and groups access this folder
Shared Folder Location locally. For network access to a shared folder, the mare restrictive of the NTFS
o pemissions and the share pemissions corfigured for the share protocol determine the
NTFS Pemmissions level of access granted to users and groups.
Share Protocols
Review Settings and Create
Share Path:
Confimmation IH:\GusterTemp
Do you want to change the NTFS pemmissions for this folder?
" Mo, do not change MTFS pemissions
{* Yes, change NTFS pemissions
To change NTFS pemissions, click Edit Pemissions.
Edit Permissions. .. I
Far more information about sharing and permissions, see Manzaing Permissions
for Shared Folders.
< Previous MNext = Cancel
3. To add new users, click Add... The Select Users, Computers, Service Accounts, or Groups dialog box will open.
Add the two previously created users from the cluster2008r2 domain and click OK.
select Users, Computers, Service Accounts, or Groups ilil
Select this object type:
Il._lsers. Groups, or Buitt-in securty principals Chject Types... |
From this location:
Iduster?ﬂﬂﬂl’?.m Locations... |
Erterthe object names to select (examples):
node1admin inode 1admin@cluster2 00802 ) ; Check Names |
nodeZadmin (node Zadmin@cluster2008r2 )
Advanced... | QK I Cancel |
P
4.

Give full access permissions for the folder \FC10ProcServer\ClusterTemp to the users nodeladmin and node2admin.
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S.

l Permissions for ClusterTemp

Security |
(Group or User names:

B2, SYSTEM B
2, Administrators (NODEZ2\Administrators) J

node Tadmin (nodeladmin@cluster2008r2 )
3, nodeZadmin {node Zadmin@cluster2008r2 )

52 Users (NODEZ\Users) -
1| | »

Add | Bemove |
Pemissions for node 1admin Allow Dery
Full Control O =
Modify O
Read & Execute O
List Folder Cortents O —
Fiead O -

For special pemissions or advanced settings. et |
click Advanced. ==

Leam about access control and permissions

[ ok | camcel | popy

Choose SMB as the protocol over which users will access the folder.
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i® Provision a Shared Folder Wizard (FC10ProcServer)

6.

In the Description field, provide a description for the folder which will help you with support and maintenance in the fu-
ture. Click the Advanced... button to edit access permissions for SMB-based access.
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% Provision a Shared Folder Wizard (FC10ProcServer) _ 1Ol x|

SMB Settings
2]
Steps:
Specify how this shared folder is to be used by clients accessing it overthe SMB
Shared Folder Location protocol. You can use the description to add comments about how the shared folder
o iz used. You can also control advanced SME settings including the maximum
NTFS Pemmissions connections allowed, access-based enumeration, and offline availability.
Share Protocols
SME Settings Share path:
SME Pemissions |\‘\FC1DPHOCSEF{VEH\GusterTemp
DF5S Namespace Publishing Description:
Review Settings and Create This is temporary folder for FlexiCapture 10 Processing Servers operating in Failover
Share Cluster FC10ProcSenver
Confirmation
— Advanced settings
User limit: IMa:dmum allowed

Access-based enumeration: IDisabIed

Offline settings: ISeIected files and programs available offline

To change these settings, click Advanced. Advanced... |

< Previous | MNext = I Cancel

7. Click Add... The Permissions for ClusterTemp window will open. Add the two previously created users from the
cluster2008r2 domain and click OK. Give the users nodeladmin and node2admin full access permissions for
\WFC10ProcServer\ClusterTemp.
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8.

l Permissions for ClusterTemp

5emr'r11.r|

Group or User Names:

E?_, Evenyone
1 node Tadmin {(nodeladmin@cluster2 00802 i)
l nodeZadmin (nodeZadmin@cluster2008r2 )

Read

Add... Eemaove |
Pemissions for node 1admin Allow Dery
Full Control O
Change O
O

Leam about access control and permissions

oK Cancel

Apply

If you want to publish the SMB share to a DFS namespace, select the corresponding option and click Next.
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i® Provision a Shared Folder Wizard (FC10ProcServer)

ﬁ DF S Namespace Publishing

9.  Check your settings and click Create to create the shared folder.
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% Provision a Shared Folder Wizard (FC10ProcServer) _ 1Ol x|

Review Settings and Create Share

R

Steps:
To provision a shared folder with the following settings. click Create. To change any of
Shared Folder Location these setting, click Previous or select the appropriate page in the orientation pane.

MTFS Pemissions

Share Protocols Share folder settings:
SME Settings lhare on FC10ProcServer ;I
Share location: H\ClusterTemp
SME Pemissions MTFS permissions:
o BUILTIMN"Administrators = Allow:: Full Control {explicit)

DFS Namespace Fublishing CLUSTER2008R2\node admin = Allow:: Full Cortrol {sxplicit)

. . CLUSTERZDDE8RZ2 \nodeZadmin = Allow:: Full Control {sxplicit)
e BUILTIN Administrators = Alow:: Full Control (nherted)

NT AUTHORITYSSYSTEM = Allow:: Full Contral {inherted)

Corfirmation CREATOR OWNER = Allow:: (inherited)

BUILTIMUsers = Allow:: Read & Execute | List Folder Contents |
BUILTIN%Users = Allow:: Create Folders / Append Data (inhertec
BUILTIMNUsers = Allow:: Create Files / Write Data (inherited)
Share over SMB: Cluster Temp
Share path: \WFC10PROCSERVER\ClusterTemp
Description: This is temporary folder for FlexiCapture 10 Processin
User limit: Maxdimum allowed
Cffline setting: Selected files and programs available offline
SMB pemissions:
Everyone = Allow:: Read
CLUSTERZ2D08R2node Tadmin = Allow:: Full Control
CLUSTERZ2D08RZ2\node2admin = Allow:: Full Control

w
| | »

< Previous | Create I Cancel

10. Click Close to complete the creation of the shared folder.
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Setting Up the Cluster Nodes

Next you must set up the cluster nodes Nodel and Node2. The instructions below apply to Nodel. The other nodes are set up

identically.

Setting Up the ABBYY FlexiCapture 10.0 Processing Server Local Service

To set up the service, complete the following steps:

1.  Enter the following command in the command line (cmd.exe):
sc config ABBY'Y.ProcServer.FlexiCapture.10.0 binpath= "%systemdrive%\Program Files (x86)\ABBYY FlexiCapture
10.0 Servers\FlexiBRSvc.exe \service -stationType:server -inifile:\\fc1Oprocserver\ClusterTemp\ServerSettings.xml"
This command changes the default settings for the process ABBYY.ProcServer.FlexiCapture.10.0, which is launched
from the file "%systemdrive% \ Program Files (x86) \ ABBYY FlexiCapture 10.0 Servers \ FlexiBRSvc.exe", and
sets the path to the following file that contains the settings for the Processing Server: \ \ fc10procserver \ Cluster Temp
\ ServerSettings.xml. Now the file ServerSettings.xml will be stored in the shared folder and will be available to all

nodes in the cluster.

2. Find the service ABBYY FlexiCapture 10.0 Processing Server in the list of services (Start > Administrative Tools >
Services). Right-click the service and choose Properties.

Q Services

Fle Actom View Hep

=10l

&0 FlEczHRD[ > 0P

Server

Saop e service
Restart the service

D=scription:
AZBYY FlexiCapturs Processing Server
Service

=i Services {Local) {3 Services (Local)

| Descriation | Status

| startup Ty = |

ARBYY FlexiCapture 10.0 Processing MName <
k

&k Application Experience

& Application Host Helper Service
& Application Id=ntity

& application Information

& Application Layer Gateway Service
& Application Management

&L ASPMET Statz Service
\E}Background Intzligent Transfer Servics
£ Base Filtering Engine

&k Certiicate Propagation

& Clustzr Servige

ELICNG <gy Isolation

ELCOM+ Event System
ELCOM+ System Application
EhComputer Browser

& Credential Manager

S Uryprographic Services

&L DCOM Server Process Launcher
&

ELDFS Namespace

£ DFS Replication

al

10.0 Licensing Service

R_‘;Dtskup Winduw Manager Session Marager

ABBYY Flex Started ALtomatic

ABBYY Flex.. o

Processes ... o ZH al | |
Provides a. .. atic
Determines.. foeLme al
Fadltates t.. e al
Provides su..  All Tasks b |al
Precegsesio,. . |al
Provides su.. ETET al
Transfers fi.. Propeortics al
The Base Fi..

Copies use... Help

Enables ser.,, Started Automatic
The CHG k... Manual
Supparts 5., Started ALtomatic
Manages t. .. Manual
Maintains a... Disabled
Provides se... Manual
Frovides fo... Started ALtomatc
The DCOM... Started ALtomatic
Provides Du.. Slarbed AL lumalic
Enables yo... Started ALtomatic

Enables yo... Started .-'\Lhomaﬁ—clll
| >

Exlermled A Slandard I

|Dper|s the properties dislog box for the current selection.

3. Make sure that the parameters you typed in the command line are displayed in the Path to executable field.
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4.

F "

SBEYY FlexiCapture 10 Processing Server Properties (Local Comput., @

Lieneral | Lag On I Fecovery I Dependencies|

Service name: ABBYY ProcServer FlesiCapture 100

Dizplay name: ABEYY FleriCapture 10 Processing Server

Description: ABEYY FlexiCapture Proceszing Server service -

Path to executable:
stationT ppe: server -inifile: \Wol OproczerversCluster T emphS erver S ettings. xml

Startup tupe: [.&.utnmatic 7

Help me confiqure zervice startup options,

Service statuz:  Stopped

Stop Pauze Bezume

“'ou can specify the start parameters that apply when you start the zervice
frarm here,

Start parameters:

)4 ] [ Cancel Apply

Go to the Log On tab. For Nodel, change the user NetworkService to nodeladmin. For Node2, change the user Net-
workService to to node2admin. Click OK.
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‘General LogOn |Hecnver'_.r Dependencies

Log on as:

™ Local System account

™| &llow semvice to interact with deskiop

% Thiz account: Inu:u:le'ladmin@clusterEDDErE.n_l

Password: I---------------

Confim password: I---------------

Help me configure user account log on options.

oK

Cancel

Apply

Changing the variable % appdata%

The service ABBYY.ProcServer.FlexiCapture.10.0 creates and stores session data in the location referenced by the variable
Y%appdata%. The users nodeladmin and node2admin must have the same folder specified for %appdata% in order for the service

to switch between cluster nodes.

Important! For the user cluster2008r2\node1admin, the variable %appdata% must be changed on Nodel. For the user clus-

ter2008r2\node2admin, the variable %appdata% must be changed on Node2.

You can change the variable %appdata% through the command line or directly in the registry.

To change %appdata% through the command line:

1. Enter the following command in the command line (cmd.exe):

REG ADD "HKCU\Software\Microsoft\Windows\CurrentVersion\Explorer\User Shell Folders" /v AppData /t
REG_EXPAND_SZ /d \\FC10ProcServer\ClusterTemp, where \FC10ProcServer\ClusterTemp should be replaced wit

the path to your folder.

2. Confirm that you want to change the AppData folder if it already exists.

3. Repeat steps 1 and 2 for Node2.
To change %appdata% directly:

1. Find the key HKEY CURRENT USER\Software\Microsoft\Windows\CurrentVersion\Explorer\User Shell Folders in

the registry.

2. Ifit doesn’t already exist, create a REG_EXPAND_SZ type variable with the name AppData in this key. Set its value to

\\FC10ProcServer\Cluster Temp.
3. Repeat steps 1 and 2 for Node2.

Connecting the Processing Server Monitor

To connect the Processing Server Monitor, choose a node to which the FC10ProcServer service will belong, then open the
Processing Server Monitor on any computer in your LAN and add the clustered Processing Server.
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@J Add processing server - | Ellil

Enter processing server location:

% Network host:

fc10procserver|

™ Local host

QK I Cancel

Setting Up the Licensing Server

The Licensing Server service can be added to the cluster identically to the Processing Server service.

You can use separate serial numbers for each node or use a license with the same serial number for all nodes.

The stations must be restarted after the service switches between the cluster nodes. The Processing Server stops and automatically
starts in 5 minutes. The remote stations continue working with their tickets if the same serial number is used for all of the cluster
nodes.

A separate log file with page use statistics is created on each cluster node in the folder %alluserspro-
file%\ABBY Y\FlexiCapture\10.0\Licenses. To obtain summary statistics, the values from all of the nodes must be added.

Setting Up the Application Server (and clustering the Administration and

Monitoring Console and Web Data Verification Station)

The ABBYY FlexiCapture 10 Application Server can be deployed on an NLB cluster to balance workloads and speed up query
processing.

Detailed information about Network Load Balancing technology can be found on the Microsoft website.

Setting Up an NLB Cluster for the Application Server
In this section, you will find step-by-step instructions for setting up an NLB cluster for the Application Server.

The Administration and Monitoring Console and Web Data Verification Station are clustered together with the Application Serv-
er.

A detailed overview of NLB cluster settings can be found on the Microsoft website.

Note. The addresses, computer names, domain names, etc. used below are not mandatory and may be changed by the administra-
tor.

Setting Up the Cluster
To set up the cluster, complete the following steps:

1. Install the Application Server on each cluster node. The database, File Storage Folder, Processing Server, Licensing
Server, and Application Server clients must be located on a different computer, which must be accessible to all nodes in
the cluster.

2. In Windows Features, add Network Load Balancing to each node in the cluster. This can be done by clicking the Add
Features link in the main window of the Server Manager (Start > Administrative Tools > Server Manager).

3. Assign an IP address to the cluster via which the cluster can access the nodes as a unit. (This is a virtual cluster address.)

If a single network interface is used for client/cluster traffic and other network traffic on the nodes (as is usual in Multicast
mode), each host in the cluster must have a dedicated IP address (in addition to the virtual address, which is common to all
cluster nodes). A host will use its dedicated IP address instead of the virtual cluster address for incoming connections to the
cluster nodes over Telnet, SSH and other protocols, and for outbound connections from the cluster nodes.

All cluster nodes must receive all incoming cluster traffic. The balancing algorithm determines which cluster node should re-
spond to a given query. The choice between Unicast and Multicast depends on your network configuration.

4. You can use the Performance Monitor for IIS (accessible through the toolbar of the Microsoft Management Console
(MMC)) to monitor node activity. In the Web Service object, for each node, add the ISAPI Extension Requests/sec
counter for Default Web Site (this is the location of the Application Server in the IIS).

Selecting the Unicast or Multicast Method of Distributing Incoming Requests

The choice between the Unicast and Multicast methods depends on your network configuration. A detailed description of the two
methods can be found on the Microsoft website.
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Balancing Workloads in the Cluster, Setting Up Hosts
You can set up cluster traffic to be balanced and filtered by ports.
ABBYY FlexiCapture 10 requires the TCP protocol for its operation. There are two filtering modes: Single Host and Multiple
Host.
. Single host
This mode provides fault tolerance, but does not allow load balancing. Only one cluster node is active at a time.

o Multiple host
Traffic from a predefined range of ports is handled by the node with the highest priority in the cluster. All cluster nodes function
simultaneously.
This mode provides both workload balancing and fault tolerance.
Traffic from a predefined range of ports is balanced among nodes. You can also set the Affinity parameter to:

e  None (not recommended)
If this option is selected, multiple connections (TCP sessions) from a single client can be handled by different nodes.

e  Single (recommended)
If this option is selected, all connections from a single client are handled by one node.

e Network (Class C) (recommended)
If this option is selected, all queries from the TCP/IP Class C address space are handled by one node. This may be ne-
cessary if there is a proxy server between the client and the cluster.

Setting Up the Application Server
Complete the following steps to set up the Application Server:

1. Create a shared folder that can be accessed by all of the nodes in the cluster.

2. Install Microsoft SQL Server. Microsoft SQL Server must be available to all cluster nodes.
3. Install the Application Sever on all cluster nodes.
4

On the first cluster node, run the Administration and Monitoring Console and create a database and specify a shared
storage.

5. On each of the remaining cluster nodes, run the Administration and Monitoring Console and connect to the database
you created.
Important! For this operation, SQL authentication must be used.

6. On the SQL Server, give full access permissions for the database to all users on all cluster nodes under whose accounts
IIS is running (the World Wide Web Publishing Service must be running in the service list). Permissions for the first
node are given automatically when the database is created, other permissions must be given manually. By default, IIS
runs under the user Network Service. In this case, assuming IIS is running on computer NodeN, you must give full
access permissions to the user DomainName\NodeN$ on the SQL Server.

7. If the Application Server is not unavailable in the cluster, but PING requests still reach the cluster, check if IIS is avail-
able in the cluster. To do this check, place a static *.html file in the folder %systemdrive%\inetpub\wwwroot (usually
this folder already contains an iisstart.htm file) and open this file in a browser: \\ClusterAddress\iisstart.htm. Pay atten-
tion to the proxy server settings in your browser when opening the file.

Running Server Application Clients
We recommend that you place all cluster nodes in one domain and run Application Server clients under domain user accounts.
Running Application Server clients under local user accounts is not recommended for the following reason.

In the usual (i.e. non-clustered) configuration of the Application Server, the following authentication method may be used: on the
computer where the Application Server is installed, a local user is created, with its own user name and password; now any client
may connect to the Application Server under this user’s account.

In a clustered configuration, the Application Server that processes client requests may be placed on different computers, and the
actual user name will change accordingly: on the computer nodel, the user name will be node1\User, while on the computer
node?2, the user name will be node2\User. This may disrupt the operation of the system.

Running Application Server clients under domain users avoids this problem.

To connect clients on remote computers which are not in the domain, you can use basic authentication and a user account in the
domain to which the cluster belongs. Suppose the clustered Application Server is in the cluster domain and the computer of the
verification operator is not in this domain. All you need to do is create in the cluster domain an account for the user clus-
ter\VerificationOperator and communicate the account name and password to the verification operator. Now the verification oper-
ator will be able to connect to the Application Server using this account and basic authentication on the Verification Station.
Note. To use basic authentication for clients, be sure to enable basic authentication for the folder FlexiCapture10\Server in IIS.
Otherwise, users will get HTTP 401 error when attempting to connect.
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Technical Support

Should you have any questions regarding the installation and use of ABBY'Y FlexiCapture 10, please contact the ABBYY tech-
nical support service or the technical support service of the ABBYY partner from which you obtained the software. For contact
details, see the Technical Support section of the ABBYY website at www.abbyy.com.
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